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Introduction
You never get Lost
i i nz AtlasHold is creating in automatic a:
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You can Fly to the Wpt and approach the Rwy.

* A Virtual Runway at any World position Lat/Lon.
Just click on the [ V ] button. Fly and return.
A classic example is the “V” on the Sea.

The name of this application comes from the original idea of creating an "IAS HOLD"

feature for any Airplane.

« This system is not using any V/S or invisible flaps.

* You can use it with any Airplane. NO NEED of a Autopilot.

« The ATlasHold is only based on Engine Pressure.
 Aunique feature.

All other functions were added later.

» ATlasHold is working with FSX, MSFS and X-Plane using FSUIPC, FSUIPC7, XPUIPC.

ATlasHold is in use since 2011.

Credits to:

* Pete Dowson the author of the MakeRunways utility and FSUIPC / FSUIPC?7.

* Paul Henty (Author of the FSUipcClient.dll)

* Ed Williams and his Aviation Page: https://edwilliams.org/avform147.htm


https://edwilliams.org/avform147.htm
http://www.intrasystem.it/ATIas/Readme_205_08-2023.txt
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New Keyboard connection, Glide Path Slope Editor, Virtual Runway Editor

Install ATlasHold

With one click create a Virtual Runway on Air, Ground, Carrier and return to.

Read New Features +Troubleshooting

. When you install this version as update pls. Read: Joystick + Keyboard Editor

. Create a NEW FOLDER (example: 'ATlasHId")

. Unzip the ATlasHId.zip into the new Folder

=i~ Create a Desktop Connection x (ATlasHld.exe).

« VIDEO + PROGRAM COLOR APPEARANCE
You should USE THE WINDOWS CLASSIC Desktop appearance for Windows 7.
Open the Program with 'Administrator privilege'.

Open AtlasHold when your Airplane is sitting on a Runway or on the Air !
Pay attention to the Tooltips + [ H ]Jelp. Mouse Hover over all Labels + Fields.

Pls. Note that the text of larger messages can be enlarged. Ctrl + Mouse-Wheel.

NOTE:

When you open the program you have to select the Joystick File suitable for the simulator in use.
Included are 3 files. (Saitek PRO) For FSX, MSFS 2020 + X-Plane.

You need to adjust the data for your joystick, Keyboard and Simulator in use.

Or, create a new file with the name you need. (depending on the Simulator)

Remember and consider: FSX, MSFS, XPlane are setting some Joystick values on different
buttons and Keyboard. (Saitek Yoke Pro)

Read the Readme File x version 2.0.5!


http://www.intrasystem.it/ATIas/Readme_205_08-2023.txt

F
ATlasHold - 2.0.3 Feb/2023

New Features

click

Troubleshooting

The Virtual Runway Selection View. Save + Select.

Joystick + Keyboard Editor

Glide Path Slope Editor
Free Flight

ATlasHold BackGround View (4 colors)

Flight Route with Rwy Take Off and Landing View.
Test Flights FSX, X-Plane, MSFS

Altitude in Feet + Meters. las/Knots / Groundspeed / Kilometer
Set the Autopilot AP Speed using the MouseWheel

The TURN Angle selection. Xwpt > Rwy

How start ATlasHold
The new Joystick + Keyboard Mouse click connections

Read the Readme File x version 2.0.5!


http://www.intrasystem.it/ATIas/Readme_205_08-2023.txt
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Open ATlasHold with Admin privileges. 4 Special Keyboard connections — Reserved
Open ATlasHold when you are sitting on a Rwy or on Air. -Open the Flight Panel
ATlasHold is only opening after selecting a Apt + a Rwy! Ctrl + Back (*Back)
* Open the Flight Plan
*Yet do not activate the Keyboard connection. Ctrl + RShiftKey (*RShiftKey)

« Start the Flight Plan. (or [flpl] button Big Radar)
] ] Ctrl + Return (*Return) (2 x)
Read the Readme File x version 2.0.5! * Open in sequence the Flight Panel View buttons:
Ctrl + P (*P) >>> APLF, FREQ, (T)CAS ... APLF

- Confirm your Simulator *.ini File. Eventual updates (new items) is done in automatic with a Msg.
- The small Main View is opening. Click on the triangle and open the Flight PANEL
- The Cursor is in the ICAO Field. Input a destination Airport and click on [Apt's]
using the Kbd use: Icao Field > Tab > Spacebar or Enter
- Now click on the ICAO List Item and open the Rwy-Selection
- Select a Runway > follow the messages and confirm yes or no. You are confirming the departure Apt + Rwy.
- Terminated. Now you can open the Keyboard connection with “Ctrl + F12” (*F12)
- Open the Flight Plan View and open the BackGround View (click into the small circle).
- Important: Open the big Radar then the Flight Panel > [APLF] View. This is the main connection
between ATlasHold and the Simulator. You see what is “ON” and should be closed.
- Now you created a Free Flight Plan, not a saved Flight Plan. Set the V/S distance
- Open the Take off and Landing View [ Runway ] Button.
- Select your Approach Altitude ! Read about here >
Only the Flight Panel > [ wpt ] (virtual) and the [ rwy ] selection are possible. Read the Tooltips.
Fly around and if you want approch the airport select [ xwpt ] and then [ rwy ] after arriving at the Wpt.
The Descentometer is now active. With the “Diamond” centered start the [V/S Rwy] approach.
You could select your departure apt as destination apt flying to the wpt and returning for landing. @ Wpt + Rwy
- If you want this basic Flight Plan as a saved Flight Plan then you must add the Wpt + Rwy as final and save.
- Open the Flight Plan View and select a saved Flight Plan.

Any other detail is explained with this Help File. Select your Shortcuts with the Joystick + Keyboard Editor.

Don't forget that some Kbd-Connections could interfere with the Simulator or viceversa.

You can use Kbd Keys or Mouse clicks with or without the Ctrl Keys. This aspect is important.
Example: The Joystick “Shift” button could interfere with the Number Pad zero “NumPad0” Key. (FSX)
Test it before with vour simulator.


http://www.intrasystem.it/ATIas/Readme_205_08-2023.txt
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* ATlasHold is only opening after a Airport and Runway selection. This does not mean that you have to use a Flight Plan or the like.
After a Destination Apt + Rwy selection this data is saved as Free Flight and the virtual waypoint is created.
If you want fly to “ LOWG “ you must use “only” the Flight PANEL [ wpt ] + [ rwy ] buttons. “Manual selection” or Joy or Kbd Shortcut.
At the xwpt you select “rwy” (not automatic). Now the descentometer is activated. [V/S rwy] automatic GlidePath approach is possible.

Flight Plan x F5X

On Radar: From > To. No Rwy.
Rwy data not visible.

Departure | LIMB Hw-_.-|32 || 1342 | Select H
Destination WG Inter=ection (] Virtual Wpt Exit

I:I I:I I:I I:I ] Fwy Approach | X LJME > LOWG

Runway

If you save this basic Flight Plan the "virtual wpt" (wpt) and the "Rwy Approach” (rwy) must be added. Always as last Fipl data!

Flight Plan x F5X

Depature | LJMB | Rwy[32 [ 1342 | Select H After :aVlr]Q, tRetBadaRr
i is evidencin s + Rwy name
Destination \ VOR ADF Intersection Virtual Wpt Exit g Ap y
00Ca GOLDSTOWNE GTS 3038 35.350525 -116.888367 -~
ooM THICPFEN FIELD 351 31 .553700 -85 234500
O0R LIVINGSTON MUNICIPFAL 151 30.685300 -95.017300
oov MEADOW LAKE 6874 38.5945400 -104 .563500 « ”
DOWI NORTHERN LITE 860 44 304283 -89.050111 You could start from “LJMB
O0XA WISKEY RANCH 271 30.224039 -96.014153 and fly To “LJMB”.
01 PEEFY WARSAW 1557 42 741800 -78.043500 H I1; ”
01ID LaVa HOT SPRINGS 5268 42 e0BZ2E0 -112.032461 b Fly to the VIrtuaI Wpt XWpt
and return for landing.
t
F :’;Y Or
] from destination fly back to the
xwpt, return and land again.
F

* A Free Flight is possible during a Flight Plan execution but the Flight Plan must be interrupted. Can be re-activated from where you left.
When you interrupt a flight plan the plane is continuing and therefore when you return to the flight plan you have to consider
whether the plane is in front of or behind the waypoint before the interruption. You can select any different WPT Item from the List.

Radar > Fly to VOR or ADF > | Vor/Adf/int See > Radar 1/9 See > Flight Plan interruption
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The new Free Flight Concept

Big Radar
Vor/Adi/int | 1) This Button is used on Ground for selecting Wpt's to be used with the Flight Plan.
L-Click

R-Click 2) While flying — Radar > Show VOR + ADF around, select (R-Click into the image center) and Fly To.
This is possible with Free Flight and Flight Plan flying.
Just L-Click on this [ Vor/Adf/Int ] Button. (On/Off > Vor/Adf)
When OFF the airplane is again following the Flight Plan.

3) Free Flight - R-Click on the [ Vor/Adf/Int ] Button.
Flight Plan flying must be interrupted if active. The [ flpl ]Jbutton background is now “Yellow”.
Autopilot, Hdg, Alt is closing.

- Interrupt the Flight Plan > AReturn (R-Ctrl + Return Key). (Same is activating the FLPL)
- The FlightPlan View is closing in automatic.
OR
- L-Click on the [ flpl ]Btn is opening the FLPL View and interrupting the FLPL.
- R-Click on the Flpl-View (Radar) > Exit

- R-Click on the [ flpl ] Btn is just opening the Flight Plan View.

4) Close the Free Flight > L-Click on [ Vor/Adf/Int ] Button.
- The Flight Plan is activating.
- Your cruise Flight Plan altitude is reactivated.
- It is suggested to engage the Radar [ V/S dist ] button for reaching the FLPL Cruise ALT.

Nota:
When you change the Altitude during a Free Flight and a Flight Plan is active.
When you engage the Free Flight it is possible that your Autopilot (closed) is still using the set ALT.
To avoid this UNLOCK the AP-ALT.
- R-Click on the the Main-View [ Alt/Lock ] button  or
- R-Click on the Runway + Landing View [ ALT ] button near the PFD or
- Use a Joystick or Keyboard ShortCut you set with the Joystick Editor View.
- Now the ALT-LOCK button is evidenced with a Red color. (it is On)
- The AP ALT command must follow in order to close definitly the AP-Lock.

Personally i'm just using F4 (UnLock) then F1 (AP-ALT) as Kbd shortcuts.

2/2 E

Radar Button

K ~Return (Kbd)

L-Click

R-Click



ATlasHold — 2.0.0 Nov/2022
Joystick + Keyboard > Mouse click connections

The Local ATlasHold Views. Reset to the saved Video-Pos

Read the Readme File > Positionclick

Joystick + Keyboard exec MouseClick x,y

stl oe? tet" file

Load

Files: 9

LastLocl.txt

LastlLocl2.txt
LastlLocl3.tXxt
LastLocl3.tXt
LastLocld.txt
LastLoc3.txt
LastlLocd.txt

LastLoc7.txt

LClick

Save as Default

Saved Default Files

(3

LastLocl.def
LastLocl2.def
LastLocl3.def
LastLocl5.def
LastLocl.def

LastLoc3.
LastLocd.
LastLoch.
LastLocT.

def
def
def
def

Take Cff and Landing View"

Load Default

Restore Default

H

Position Click

Keyboard Click Position Joystick Click Position
New Position Exec — New Position IEI!!I
Keyboard Key Wi Joystick Number

Save Kbd Key

Drescription

Save Joystick

Simulator

Fit Panel Rwy Radar

| #Plane ~| H

Ebd, Flt Plan, “NumPadl, 1744,551, &ny
Ebd, £r, “NumPad3, 1877, 500, Any
Ebd, £1t plan T, “NumPad4, 1278,75¢, Any
Ebd,Flt Plan ADLF, “NumPadZ, 1872, 2£9, Any
Ebd,Radar Dist, “NumPadS,531,1024,MSFS
Joy,Settings View,524288,3795,49,X-Plane
You save only 1 Position but
You need 2 clicks for opening the Menu on Top
and the X-Plane Setting Button (Arrows).

ATlasHold includes the Keyboard-Hook System and the MouseClick-Hook system.

Using Number PAD 0 to 9 or Kbd numbers DO to D9
or Alfa A..Z/a..z or Joystick Btn number.

The aim is to significantly increase the connection possibilities between ATlasHold and any other View such as an Airplane Cockpit or the Simulator AND

the various views of ATlasHold.

(This feature is similar to the enclosed software "MouseClicks" but only for single "clicks")

In other words, this function performs a "click" instead of the mouse. Example: Open Views, click on a View Button or Field, Apl cockpit ecc...
This extra feature is giving you exactly what many user are searching for. You are free of any restrictions.

This can be done with the keyboard or the Joystick independently of Joystick or Keyboard connections already registered with the "Joystick" Editor.

The "Joystick" Editor already includes 2 types of connections for the same use but restricted to 16 Joystick connections + 14 Joystick > Keyboard
connections. Namely "joystick"” + "keyboard". Example: X-Plane B747 is not accepting a “external” MouseClick but only > the real Mouse-Hover click
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Views Screen Location xy

Read the Readme File > Positionclick

L Views "Lastl oc?. ixt" files as on Screen Position [X.Y) Default Files.

3t oc? txt Files in Default Files "Lastl oc?_def" files

Load

Save as Default

Jefault] from "La:

Files: 9

LastlLocl.txt
LastLocl2.txt
LastLocl3.txt
LastLoclS5.txt
LastLocl.txt
LastLoc3.txt
LastLocd.txt

LastLoc7.txt

Take Off and Landing View"

L-Click

Saved Default Fles

stl oc? def" files ﬁ"LdiLJEibﬂTHEL

(9)

Lastlocl.def
LastlLocll.def
LastLocl3.def
LastLocl5.def
Lastlocl.detf
LastlLoc3.detf
Lastlocd.detf
LastlLocS.det
LastlLocT.det

Load Default

Restore Default

H
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Troubleshooting - To date, no bugs. 1/8

* (1) Open ATlasHold when your Airplane is on Ground or on Air.

* (2) MSFS and X-Plane do not respond to the AP> Altitude (ALT) command like FSX. [V / S Dist. ]and [V / S Rwy ]

With version 2.0.5 the Autopilot is activated in automatic. This was a problem for many users.
You should know that the VIS command needs the Autopilot and is the Pilot duty.

In case of difficulty Open > Close > Re-Open the selected V/S command. Page “ Radar 9/9 was requesting it!
(the X-Plane simulator is Plane specific)

- Observe the ALT. Any step should change the ALT feet by about 10 feet + (Near the set Altitude 'less’)

Never use “Full Speed” with V/S activated. Engine pressure about 60/70 % only. VIS would not stop.

Free the Ailerons when approaching + using the automatic Approach-System!

If your Autopilot is locking the Ailerons just open + re-close the [ALT] Button! Same procedure with Heading!
This is not depending on ATlasHold!

* (3)[V/S Dist. ] Ascending or Descending — Don't fly with Full speed.

Set your engine pressure between 60 and 70 % before you reach the selected Altitude!

If you miss this the Simulator and the APL “VS” would not stop at the desired Altitude. (logic)
* (4) On Ground the AP, AP-Heading and AP-ALT should be closed before Take Off.

The AP-ALT could be ON if set by the specific Airplane or Simulator.
After Landing ATlasHold is closing the Autopilot, Hdg + Alt.

Read the Readme File x version 2.0.5!
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Troubleshooting - To date, no bugs. 2/8

(5) FSX + other Simulators
Don't use the "Y" fast forward with FSX or other Simulators when a FlightPlan is running.

This is not supported for quite simple reasons.

(6) Flight Plan View

Before you start open the [ APLF ]Panel and the [ FR ]Panel. Check Lights, Fuel, Frequencies.
(7) The Take off and Landing View is a very important instrument. Get a immediate Data overview.

(8) If you change data On Air the Runway graphic does not change / refresh. Click on the Destination
Rwy-Name “[35C]” button. The normal procedure, selecting Apt + Rwy is doing it in automatic.

(9) The “ToolTips” and “[ H ]elp” Buttons are the best way to understand what it is for.

If it is true that everything works well with one Apl and not with another, it is equally true that one
of the 2 suffers from errors.

What's a nice APL worth with an AP and coding errors ?
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Troubleshooting - To date, no bugs.

(10) Runway / Landing Approach Angle - Approach Slope

A) We must decide at which Altitude the aircraft should start the Descending Glide Path Slope.

B) ATlasHold is calculating the Altitude, based on the Rwy-Alt, and the Approach Slope angle in automatic.

We decide the Altitude below the calculated ALT at 10 + 20 nm Rwy-Distance.

Lower the Altitude nearer to the Rwy the approach Slope is starting.

[ ]
Apt

%' . Kbd Information

Connect to a real Airport Information Center.
L-Click = connect to " flightaware " world apt information

C) We must take into consideration eventual obstacles like hills.

Carefully study your Airport /| Runway approach.

R-Click » connect to " SkyVector.com", World Apt's + Charts,

Adjust your Altitude.
The Glide Slope Diamond is centered when you reach the altitude set based on the Rwy-Distance!

The [ VIS rwy ] is starting when you decide it. Automatic Alt adjusting as per Rwy distance.
With a Cessna no problem. A Liner is quite different. Do not repeat the real world Pilot errors.

(11) Departure + Destination Runway Coordinates Latitude + Longitude — Important is the destination Rwy

It is useless to claim for incorrect Rwy coordinates. As explained any Simulator is using slightly different Coordinates. But you are landing.
ATlasHold is using the FSX Default coordinates. You should use the included 2 programs:

RwyLength_(Modify and create new Rwy's with different names for any single Simulator — FSX, MSFS, X-Plane) > RwyLength

AddAirports (Modify and create new Apt's + Rwy's) > AddAirports
Glide Path Slope Editor

This programs are in use since more than 10 years and Bug-Free.
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Troubleshooting - To date, no bugs.

F 4/8

(12) Runway Landing

The automatic [ V/S Rwy ] Glidepath / Approach is requesting a correct Aircraft asset. Read
Speed + Flaps Don't forget to set the Throttle to Minimums before Landing. Page 7/7

Don't change the Altitude “Y” near the Rwy. You alter the ALT and Asset.

The only possible small correction is the “X-Axis” left/right heading just before touch down.

Don't extend the Flaps to Max too early!

Wind ? You can set the Wind correction heading with ATlasHold. Wind - Heading

(13) The correct Joystick Autopilot AP command.

ATlasHold is correcting it in automatic after a save + reopening.
The Joystick command for the AP must be set!
For the Joystick it is mandatory to indicate a Joystick

command or a dummy value like "700000".
(value not in the Range of possible values)

Joystick Connections
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Troubleshooting - To date, no bugs.

* (14) Keyboard Hook system — Kbd Connection blocking
A simulator uses the Keyboard Hook system like ATlasHold.
Delete FSX Keyboard Connections in FSX. They are useless. In any case make a test.
In particular the FSX function keys F1..F12 and the Number Pad keys 0 to 9.

The Reverse thrust + Spoiler on Ground can interrupt the Kbd Connection!
Important general Check — Close the Kbd-Connection before #12 (Ctrl + F12)

A) Open the Joystick View and select the actual Joystick “.ini “ File in use.
B) Select 1 “Joystick” Button in use with one of the Joystick Items.
C) If the returned value is different (much higher) then there is a Flight Yoke connection problem.
Your USB-Saitek connection Driver is not connecting properly.
- Close ATlasHold
- Restart your Saitek Installation program that is including the Driver.

The Kbd-Connection is always active and reading but not executing when you close the connection.

Joystick Connections

If you discover a interference and the key causing it, please let me know.
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Troubleshooting - To date, no bugs.

 (15) Add/Modify Airports + Runways — Add Runways + Runway Length

When you Add or Modify Airports data with the “AddAirports” program you should consider:

A) the new created file “New_apts.txt file” must be renominated into “rwy.txt” file and copied
into your actual program Folder.

B) If Runways are added or changed you have to update the “rwylength.txt” data for
runways you have added, changed or deleted using the “RwyLength” program.

RwylLength

C) If you only change the Runway Length data with the “RwyLength” program just copy the new
“rwylength.txt” file into you actual program Folder.

D) If you Add a Runway with “RwyLength” you must also update the “rwy.txt” file using the
“AddAirports” program.

A possible Add Runway example could be: FSX is the Default.
- Rwy coordinates between FSX, MSFS, X-Plane are slightly different but you are landing.
-Rwy 14 at LUMB - Add a additional Rwy 14 for MSFS > Save as Rwy “14M”
- Rwy 35C at LOWG - Add a additional Rwy 35C for X-Plane > Save as Rwy “35X”
- AddAirports is connecting with your Simulator. Heading + Coordinates are copied directly.

AddAirports RwyLength
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Troubleshooting - To date, no bugs.

(16) Joystick Editor — Added 3 additional Keyboard connections.
Mainly used with bigger Aircrafts like the Boeing 747. (A/T + SPD)

- A/IT — AutoThrottle FSX + MSFS X-Plane depending on Aircraft
- Speed (SPD) Hold FSX X-Plane Menu Keyboard > select " sim/autopilot/Autothrottle_toggle
Example: Kbd Key “ s “. This could be the “speed” SPD Button.

Similar with MSFS or FSX.

- [ Range ] Button on Big Radar (2.0.5)

. . This is for the B747. Different Apl might request a different setting.
Important is the A/T connection. In this example set the A/T Autothrottle to On/Off.

The Flight Panel > [ APLF ] is including the “A/T” las selection.

Updating your Joystick Files is Automatic > Joystick Files > *.ini files
Prior to version 2.0.3 *.ini files are updated when you start version 2.0.3.
For updating you must select the single *.ini files. A notice is advising you!

Don't forget to set the Throttle to Minimums before Landing

Joystick Editor
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Troubleshooting - To date, no bugs.

. (17) RADAR Range +
i R vz 52 Low 35 ]

Info
The visual Radar Range is selected in automatic, (Black, Yellow color)
Dark Yellow color » Range is free/open for selecting

You can Select a different visual Range:
Click on the [Range] Button.

L-Click on Radar then use the Mouse-Wheel. Color Dark yellow.

Click again on [Range] = set automatic.

With [Vor/Adf/Int] active » Range = free. L-Click » Mouse-Wheel,

The automatic Range selection is the distance to the destination Airport

The Range selection is depending on the “Range"-Button color:
- Color “ Yellow ” on startup — Fix Range to destination Apt.

- Color “ Yellow ” Range selection is free. From 1 to 3000 nm. Mouse-Wheel.

- Color “ “ Automatic Fix Range to destination Apt.

- Color “ Yellow ” Range selection is free. From 1 to 3000 nm. Mouse-Wheel.

- Color “ “ Automatic Fix Range to destination Apt.

One thing must be said very clearly.

While the simulators become more and more sophisticated the
Airplanes increase only the graphic (default or not) without taking care
of the technical part such as the autopilot.

The same airplane from different companies has a different autopilot
that does not respond correctly to various interfaces like "FSUIPC,
FSUIPC7, XPUIPC). Even the interconnection between the AP A/T and
the speed (spd) is wrong.

Blue circle

10

HEEHEEE

— Pl G e 1 £ ] 00 D

This additional feature is quite important.
The airplane is in the center of the circle.
There are 3 main uses.

1) As explained here: Big Radar 8/9

2) Adjust the V/S ascending/descending value.
- the basic distance to reach the Altitude is calculated
in automatic.
- If you_increase the distance the V/S value decreases and
therefore the data transmitted to the autopilot will be
smoother and safer. Speed is crucial!

3) Altitude Autopilot errors are avoided.

Read > Troubleshooting V/S
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First thing to do

Read the Readme File x version 2.0.5!

When you open ATlasHId the first time the request for registering is appearing.
The FSUIPC / FSUIPC7 / XPUIPC LOG-File Folder Path must be registered and saved.

Example:

"C:\Program Files (x86)\Microsoft Games\Microsoft Flight Simulator X\Modules\FSUIPC4.log"

"C:\FSUIPC7\FSUIPC7.log"

The File flppath.txt is created. (1 textline)

flppath.txt File - no empty line in between - observe the quotation marks

Sel. Distance

If this file should be corrupted delete this file and Re-Start the program.

4  Opens the Flight Panel

| I CockpitStatus ATlasHold 1.55 =10l |
Arm AT - n2
]
IH-
[Hdg 2= [At  [Rad &llas |Cn_||se ' =
BE_,E-IIEI 9 Qs
4

Stay on (T)op

First select a destination + a
Runway. Then you can open
then Keyboard connection.
(*F12)

Any Kbd Key could interfere
with your Simulator.

Read the Keyboard Page

The ATlasHold Lever PRESSURE is always working with:

FSX, X-Plane + MSFS

Big Radar > [ Runway ] or ShortCut (Joystick or Kbd) >

Take off and Landing View > Engine Pressure

Help Notice

Fly to Buttons
Virtual Runway

The help is very extensive and updated from 2011 to today.

Mouse Hover over each Label, Fields + Buttons.

1/4

The Icao Airport Selection Filter

The Icao + ' * 'is indicating ILS

Dist nm Icao Distance from Aircraft Position

[ ]

[ ] Apt's within range 50 n

m Default

[100] [ 1 Apt's in Range of 100 nm
[ ] [KJFK] Only KJFK is shown/selected
[100] [KJFK]Apt's in a range of 100nm from KJFK.

Recognize FSX, MSFS, X-Plane, Prep

)ar3D (Simconnect)

Flight Panel - M5F5

fnm-m@nm

lcao rwy nm hdg km freqg Hev [ Ry |
MINICH >hdg 302° '.
EDDM ** 195 361 1487 |
08L 081 109.50 1@
0B8R og1 105 .30 4EI|
Z26L 261 108.30 48
Z6R 261 i08.70 48

*%% Wnt 20nm Bwy-Aligned **=*

Distance, Icao, Airports,
(I)ntersections,
Distance to dest. Rwy

[Rwy] Approach Radar

™ | 2 Radar — L/R click

Flight Plans + (FSX)

TCAS FSX, MSFS

Frequencies + Mem

D\ AP

Light
Fuel

Joystick
Keyboard
Edit Joystick

4 >
wvor [ adf O rwy B wpt B Int|:|m

Eapnmm S

Help + H- Interface.

Connect to:
"Flightaware”
“SkyVector”

World Apt's + Charts
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Using different Flight Simulators

Microsoft Flight Simulator FSX

ATlasHold is using the FSX environment as Defaulit.

*FSUIPC
* Microsoft.FlightSimulator.SimConnect.dll (FSX)

* FSUIPCClient.dll

X-Plane

If you are using X-Plane download and install the XPUIPC interface.
In the ini-file write your IP Address (Server Address )

* [XPUIPC SETTINGS]

¢ Tune value =00

« Server Address = 192.168.1.64

The AP and Elevator Trim value (important for a Landing approach) is not evidenced for any Airplane (Trim Field) with ATlasHold but

X-Plane is setting the Saitek Pro Joystick for this use in automatic. (other Joysticks ?)
Example: the Citation CJ4 v 1.07 — ATlasHold is reading the TrimValue on the Runway TakeOff Display. (XPUIPC)

The X-Plane AP + Elevator Trim is very smooth.

Microsoft Flight Simulator MSFS 2020

ATlasHold is running with MSFS using the FSUIPC7 program/interface by Pete + John Dowson.
Just install the FSUIPC?7.

There are some "logical” Autopilot coding differences which FSX + X-Plane do not have.
The Big Radar Selection [ V/S Dist ] and [ V/S Rwy ] has been adapted in order to overcome this inconvenient. Same with X-Plane.

(check the AP + ALT > read about in the new Troubleshooting (1) page)

Adjust your Apl asset, flaps + speed.

Keep in mind that some Airplanes (all Simulators) both of Default or Add-Ons have different Autopilot coding errors.
(AP _not sending or AP not receiving)
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Unzip the included programs related to ATlasHold.

The programs are here:

Your programs Folder...\Subfolder

..\AddAirports  “AddAirport.zip”

...\FullSize (is installed - no Unzip)
FullSize is also listing all actually open programs. Depending on latest Window updates.

...\MouseClicks “MouseClicks.rar”

...\RwyLength “RwyLength.rar”

...\ReadFrameworks “ReadFrameWork.zip”

* 1) UNZIP only into the same Folder.

* 2) Program *.exe files: Make a direct connection to your Desktop.
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First thingtodo 4/4

You are the Pilot. Do not forget.

Use the Flight Plan or the big Radar [ Apt's ] (L)isting and change Fly-To.

A example Flight Plan could be:
>>> Flight Plan

The Glide Path Slope ENTRY-ALT is very important.
Read about the new Glide Path Slope View.

_Consider the Flight Plan Test Examples > Flight Plan

Since the virtual wpt is located at 20 nm from the Rwy a 20nm-Entry-ALT does not
guarantee an ideal Glide Slope Descend start if you approach the Wpt with a wrong
angle.

You avoid this by selecting a lower Approach Glide Path Entry ALT.

The best way is to use a Vor, Adf or intersection behind the virtual Wpt. Align!

The less the ALT closer to the Rwy the descending begins.

Crossing the virtual Wpt at 20nm Rwy distance aligned with the Rwy
The Airplane ALT should be at the same ALT as the [ GB Alt ] you select as reference.
(or less)

Remember the correct use of the Glide Slope Descentometer.
Never react fast during a final approach.
Wait and see. The Airplane is not a Ferrari.

The new Flight Panel.

Flight Panel - F5X

Connect to a real Airport Information Center.
L-Click = connect to " flightaware " world apt information

sance [ e o |
lcao ™y mm hdo km freq Eev | Rwy |

SCHONEFELD >*hdg 345" H
EDDB ** 33z 615 |

o7TL 0&6 110.70 52
25R 246 10530 52|

<
vor 3 adf 3 rwy 3 wpt 33 Int I
A-B 332/345°

R-Click = connect to " SkyVector.com”. World Apt's + Charts,




After any Aircraft or Destination change open this View.
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The Flight Panel [ APLF ] View

This is the main connection between ATlasHold + your Simulator.

Approach / Landing Radar > Flight Panel [ Rwy
‘Flight Panel - X-Plane

Distance [l R0 (IEEE 8 0 A 107
T | ADF 90 -

20 nm Range

EDMP
03 I R-Click > Close
14580

vor [ adf 3 rewy B wpt 3 Int -

A-B 67257
- Ea -

Remember:

The Distance Field is
used x different
settings.

Fly to Buttons
(V)irtual Runway
Flaps extension

ra.ﬂm-m:mm o |
Bl icao vy nm hdo km freq HBev | Ry |
Master Av Batt [ | Spoiler
Brakes [ | Pause []wvss |
AP [ FD [JHdg [ At []yaw |
(1 Nav [] Apr [] IAS Nav/Gps 1
|
Lights
Maviga Panel Beacon | -
Recog Wing Strobes m
~| Land Taxi P
LTad 3 ster Rudder 2 |
[ ] Cabin Logo F
Gallon Gall/Lbs/Kg T
cty | 59800 | 28364 |— i
i

aircraft

vor 3 adf O reey BN wpt B Int|:|m

Open from Main-View > Triangle
Open with a Joystick Mouse connection.
Open with Keyboard connection.

Open with a Mouse Click connection.

Keyboard + Joystick connections

Keyboard > Mouse Click connections

>>> Free Flight

En Hod . Gear down, Brakes On, Keyboard connected.

The VOR, ADF + Int(Intersections) are only used by the Flight Plan system and Radar View.
You can use the Wpt (never get lost) + Rwy selection for any Free flight.

[ Rwy ] is leading you to the Rwy-Course.
Instead a Landing Rwy-Approach must be selected with the big Radar [V/S rwy]
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Using the Approach System

The AT-las-Hold Feature is not using any Autopilot
just the engine pressure for stabilizing the speed.

*Your aircraft must have a Autopilot with Hold(ALT) and Heading Gauge (Hdg).
* The FSX aircraft.cfg file must include the following AP parameter section:

A sTlasHold 2.0.4 %86

mEEm . (WE - Fa
|140 = *1 -_ | 75.207s2 |
[ autopilot ] i
autopilot_available=1 e e e ‘.a);
flight_director_available=1 =

* You can use the Default Cessna 172 autopilot — in Panel.cfg file add:
//On Top under [Window Titles] write

Window??= AP

[Window?7?] /lin place of ?? use your own Window sequential Nr.
Background color=2.2.2

size_mm=156,48

window_size_ratio=1.000

position=8

visible=0

ident=RADIO_STACK_PANEL

zorder=3

gauge00=Bendix_King_Radio!Bendix-King Radio AP, 0,0,156,48

Free the Ailerons when approaching + using the automatic Approach-System!

If your Autopilot is locking the Ailerons just open + re-close the [ALT] Button! Same procedure with Heading!
This is not depending on ATlasHold!

* Using ATlasHold with Add-On airplanes
- Some add-ons are using a own AP-System. In that case you must verify if ATlasHold can open the AP-Functions via Joystick
or the CheckBox-Panel [ APLF ] + or you should use the Cockpit-AP-Switches first.

- ATlasHold has been tested with all major Add-on airplanes without problems.
Example FSX: Stratocruiser B377 = OK, Dash8 Q400 from Majestic can use all CockpitStatus AP-Commands.
Example FSX: For the CS B-52 do not forget to set the FD (flight Director) + the Mode Selector to “Tacan”.
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AT-las-Hold System

B AtiasHold 204 x26  — = Increasing speed to a disproportionate
ThiATI?SHOII:d Stystem_ mmm . w2 E speed such as from 100 to 300. In this
anunA?:J?aneea ure x Speed Box |/ 4% = 7 case it takes time to reach 300. Fly at
y Alrpiane. 2-:-175? A b 290, 300 or 310 and then engange the
O SR o0 AT [Arm].

las-Hold is only based on a few known Aircraft-data details. This is important to know in order to use it properly.
las-Hold is using only the engine-pressure and does not know anything about your aircraft and engine type.
Do not confuse the AT-Control with a N1-Control!

* The [ | ] Button. You Fix the Hold-Speed equal to the actual Speed or manually enter the speed.
* The [ Lever/Hold ] Button can interrupt/disengage the AT and, when closed again, engage the AT at the Actual Speed.
* You can select or type any speed manually using the speed box.

* When airborn and at cruise Altitude:
- Clickon [Arm ]. (Button change color) — Disengage/Close AT-las, toggle this Button.

Move Back your Throttle Lever to the Default “Null” Position.
Engange/Click the [ AT ] Button.

The AT-las Hold procedure is starting.

« MSFS, X-Plane Simulator: No Engine Pressure ? Click on the A,N,I button (Adf, Vor, lIs) below the small PFD Instrument.

* If you change Altitude the speed will change accordingly as it is with any other Hold-Speed System.
» On Ground AT-lasHold is disengaged.

* The [ Lever/Hold ] Button can be used in any moment, with or without AT engaged. “Lever/Hold” is holding the actual
engine-pressure in place of the Throttle-Lever.

* [ Lever/Hold ] can be enganged on Ground.

* For a real 100% pressure use the Cockpit Throttle or the FSX “F4” key as a Joystick does not keep 100% pressure normally.
» The [las]Bar is indicating the selected speed in relation to your aircraft-cruise-speed.

» The Bar below is indicating your actual speed + engine pressure. Background colors, yellow + white.

* The [ Speed Box Field ] is changing color to green when you reach the desired speed. (-/+ 1 Knot)

* You must keep your hand OFF the throttle lever in order to see speed + pressure correctly.
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When there are winds blowing to the right W| nd Drlft CorreCtion . ]
or left of the plane, the heading must be F I * to LOWK fly 3(22 /12,8 nm dist.
offset into the wind in order for the plane to ue *to VOR fly 335° / 5,2 nm dist.
still fly in the same direction. «to RWY fly 283° / 8,9 nm dist.

« to Virtual wpt fly 75° / 8,9 nm dist.
Click on this Button _| * Rwy deviation -12°

» Approach ALT -108 feet = too high

. * Glide Slope Diamond “Apl too high”.

(Button Color is red when engaged) stay on course High = too Low. Low = too high.

On Ground the Wind Drift is closing. fi The Airpl Rad-AGL
e Airplane ad-

Wind Drift correction from -20° upto 20° - from left to 0 from 0 to 20° right correction. ek red NEEH ﬂ

ADF [ » | 34

Use the small arrows up/down

When opening or closing, the Wind Drift Value is always 0 (default).

For a initial Drift Value use the general Wind Drift Correction rule with ATlasHold:
Wind speed Knots: 15div5= 3 (if to left use -3 — to right use 3)
Wind speed Knots: 43div5= 8 (could be between 8 and 10)

Use this feature mainly for a Runway Approach starting at a reasonable distance.
R-Click > Close

The Wind Drift Value and direction is visible on all Radars.

You center the Rwy !

FSX
If your aircraft does not use the Fuel-Dump
Open the [APLF] Panel. FUEI you can change the Aircraft.cfg file.
Gallan 957 wpt 75° /89
cty [ 1516 | 1435 mwansamnani| 81 Under the [fuel] section add: EN -
fuel_dump_rate = 0.00685 €3 2 | FwvBakd 10
Click on [Fuel] Re-Fuel 50 % of Total Cpty. = e
Click on [Gallon/Lbs] change measure. (the % of max Qty dump x sec) W AB1z302 1AC5A T H

Input 60 into the Distance Field. Fuel 60%.




The new Joystick and Keyboard Open>Select = |  MSFSini Kbd s

connection 65536 ~
Editor [Brakes]

64 Exchange: F1 with F1 ey

Read the "Saitek Pro Joystick Defaults.txt" File. [Spoiler 40%]
128 (F1)is assigned for. [Kbd-ALT Autopilot]

[ Joy Number ] _
[AP/Elevator Trim

Is reading the Joystick Button number/value 4
[AP/Elevator Tri:ﬂ OK

Is reading a Joystick number you input 8

L [Runway View]
[ Joy Description ] 524288
o . _ [V/S ALT] Read the Readme File
Is evidencing the Joystick number description. .
J y P 16 x version 2.0.5!

Same with [ Description Help ] [V/s Rwy GlidePath] Readme_ 205 08-2023.txt
32

10 (12) Keyboard connections same as Joysticks [Kbd-ALT Autopilot]

rplacingthe provious Pridg selecton x Fx.

The KBD connections are evidenced with the [Kbd-EDG Autopilot]

prefax “ Kbd- “
F2
[ Spoiler 40% ] the description Field [Kbd-AP Autopilot]
F3
128 is the Joystick r]umber value assigned. [Kbd-ALT-LOCK Autopilot]
“0” = don't use it.
F4
Read the [ Help ] [Kbd-RunwayHeading]
A
R

Switching between simulators can cause you to lose the Clear Fields
original Joy data + ATlasHold may be reading incorrect Joy Value

numbers. In this case it is necessary to run the installation

file (Flight_Yoke_System ...... exe) ex new for those who use Joy Description Delete ltem

the PRO Flight System Yoke. (or else) 'Description Help | |

see > Troubleshooting 5

Exit + Save

Help Joysticks + FAight Simulators can assign + retum different Joystick values. Top
1 l4 Keyboard > Mouse Click connections

v. 2.0.4 New > Create a new Empty Joystick File *.ini Emty/New Joystick File


http://www.intrasystem.it/ATIas/Readme_205_08-2023.txt
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Airplane should be on Ground !
Be aware that Simulators are assigning some joy values in automatic you must take into consideration.

+Open the Joystick connection View. Click on the Flight Panel Button > [ Joy ] > CLOSE the Kbd-Connection before. Automatic.
The Kbd-connection is still reading the Kbd but Not executing!

» Select the FSX.ini, MSFS or X-Plane.ini file. You can create a new “ini” File with different names for MSFS ecc...
* Move the Mouse-Pointer on a Number Field (not the description field] and select.

* At the first message answer NO

* Select a Joystick button. The Value is visible. Click on the number Field selected and register the Value. “0” = don't use it.
ATlasHold is correcting it after a save + reopening.

* Multiple Joystick commands: )
Release ALL buttons TOGETHER The Joystick command for the AP must be set!
Number of buttons is indicated

! . 'S Inct For the Joystick it is mandatory to indicate a Joystick

The command value is visible

Click on the number Field selected and register the value command or a dummy value like "700000".

(value not in the Range of possible values)

The SHIFT Button Value

Keyboard > Mouse Click connections

The shift button is important and the value is 1.
Shift + button-value 64 = 65

Remember and consider: MSFS, X-Plane is setting some Joystick values on different Buttons.
(Saitek Yoke Pro)

Error control

Any Data exchange is evidenced with the actual value and new value. Confirm or Not.
If a command value is already existing / assigned a message is advising you.

NOTE:
* When you open the program you should select the Joystick File suitable for the simulator in use.

Included are 3 files. (Saitek PRO) For FSX (MSFS 2020) + X-Plane.
You need to adjust the data for your joystick.
Or, create a new file with the name you choose.



E Flight Simulator / Joystick interface > Keyboard connections

Airplane should be on Ground or On Air !

3/4

The Kbd-Connection is always active and reading but not executing when you close the connection.

The Keyboard connection is closed when you Open or Close ATlasHold

-Before opening this Editor the Keyboard connection must be closed! > Ctrl + F12 (*F12)

* The 14 Kbd items are including 10 out of the 16 Joystick connections. (new A/T + Speed)
* Instead of the Joystick value you use the Keyboard Key.

* Ctrl = RControlKey or LControlKey. The Ctrl Key sign = “ A “,
* Read the keyboard characters

* Activate the Keyboard Hook System!

* Ctrl + F12 (*F12) - Reserved

* Interrupt Keyboard Key reading > Ctrl + F12 ( AF12)

*You can use only 1 or 2 keyboard characters

* -the Left or right Ctrl Key + any Key + Shift + Alt Key > Read the Readme File x version 2.0.5!
* -any single Key

Open Kbd-Reading *F12 Error

Read the Troubleshooting 5/8

* How using the Ctrl Key + a second Key:
It is suggested to NOT use the Ctrl-Key + Key together but single.
--- In this case Ctrl-Key + Key is not interfering with Simulator actions that respond to
Ctrl + Key together.

But also the contrary applies. FSX “P” = Pause, use “*P” and Pause is not activated.

4 Special Keyboard connections — Reserved — you can't use with the Editor.

* Open the Flight Panel
Ctrl + Back (*Back)
* Open the Flight Plan
Ctrl + RShiftKey (*RShiftKey)
« Start the Flight Plan > [flpl]-button on Big Radar. Start the Flight Plan.
Ctrl + Return (*Return)
* Open in sequence the Flight Panel View buttons: APLF, FREQ, (T)CAS ... APLF...
Ctrl + P (*P)

Read the [ Help ]

When you edit a Text Field like the ICAO Field in the Flight Panel you should close the Kbd

connections. Avoid interference with your Simulator. Same applies with any other external View.

[Kbd-ALT Autopilot]
1
[Kbd-HDG Autopilot]

F2

[Kbd-AP Autopilot]

F3

[Fbd-ALT-LOCK Autopilot
F4

[Kbd-RunwayHeading]

R

[Kbd-Radar Big]

R

[Kbd-WaypointHeading]
AW

[Fbd-Runway View]

T

[Kbd-[V/S ALT]

F5

[Kbd-V/S Rwy GlidePath]
F6

The Kbd + Joystick Items:
Kbd-WaypointHeading
WaypointHeading
Kbd-RunwayHeading
RunwayHeading
are also used as Free Flight
Selection Buttons >
on the FlightPanel. [rwy] + [wpt]

The Waypoint is the virtual xWpt at
20 nm in front of the destination Rwy.
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Airplane should be on Ground !

Be aware that Simulators are assigning some joy values in automatic you must take into consideration.

Before opening this Editor the Keyboard connection must be closed! > Ctrl + F12 (*F12)
(v 2.0.3 in automatic)

Read the Readme File x version 2.0.5!

- Save your actual "Joystick Files" Folder if you update.
- Install ATlasHold
- Re-copy your saved Joystick Folder into your actual program folder.

* In your program folder there is a zip-file "Joystick Files Example.rar".
This zip-file is including 3 Joystick files i'm using for testing Joystick + Keyboard connections.

The version 2.0.5 is including the automatic update for additional new connection Items.

(with updates)

And now the important point we must consider.

Any simulator is already assigning Joystick and Kbd-Keys.

Mainly the Kbd-Keys are often useless for a prepared user.

Eliminate all "Simulator” connections you want use in a different way.
Select a Joystick or Keyboard Key and check if the Simulator is using it.

Try with a single Kbd Key and with a Ctrl + Key combination.
FSX “P” = Pause, use “*P” and Pause is not activated.

This should be done “outside” of this Editor. Connect the Kbd-Connection *F12.

* Open + Close the Keyboard connection.
- AF12 (L-Ctrl or R-Ctrl Key + F12)
- Click on the [ Kbd ] or [ Kb ] Buttons
- Big Radar
- Runway Takeoff + Landing View
- Flight Panel
- Flight Plan

[Kbd-ALT Autopilot]
1
[Kbd-HDG Autopilot]

F2

[Kbd-AP Autopilot]

F3

[Fbd-ALT-LOCK Autopilot
F4

[Kbd-RunwayHeading]

R

[Kbd-Radar Big]

R

[Kbd-WaypointHeading]
AW

[Fbd-Runway View]

T

[Kbd-[V/S ALT]

F5

[Kbd-V/S Rwy GlidePath]
F6

The Kbd + Joystick Items:
Kbd-WaypointHeading
WaypointHeading
Kbd-RunwayHeading
RunwayHeading
are also used as Free Flight
Selection Buttons >
on the FlightPanel. [rwy] + [wpt]

The Waypoint is the virtual xWpt at
20 nm in front of the destination Rwy.
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The Frequency Input View [FR]

* Button: Nav1 standby / Nav2 / Nav2 standby
* Button: ADF

* Click on the small red on white ' // ' Label, exchange frequencies.

* When you click any of the frequency buttons, that frequency will replace the NAV1 or
ADF Frequency.

* The Frequency Input Field (only numbers allowed but not the leading '1’)
Example: Freq 110.90 - Input [1090]
Example: Freq 115.00 - Input [1500]
Example: Freq 117.25 - Input [1725]
Example: Freq 108.00 - Input [0800]
Example: Freq 109.25 - Input [0925]

* Adf Example: Adf-Freq 290 -Input [290] Adf-Freq 1350 - Input [1350]

*When you press any of the Frequency Buttons, that frequency will change to the
Frequency INPUT VALUE.

* If the Input-Field is EMPTY and you press any of the NAV-Frequency buttons then this
frequency will replace the NAV1 Frequency.
This is meaning that you could prepare several frequencies for later use with NAV1.

* COM1 + COM2 Freq Input same as Nav-Freq.
Freq into 'Stby' then you should use the '‘exchange' switches.

* Make short clicks on the Freq-Button!

* Selecting Frequencies with the Flight Panel
- Rwy-ILS Freq. are copied directly into NAV1
- Vor + Nav2 Freq are copied directly into NAV2
- Adf Freq are copied directly into ADF1

Flight Panel - M5F5

rmm-m:@u m[1ss

lcao  rwy Bev T

cmy [0, [ BTN i 2
---.

o250, [ 1330 @
K2 [ 10000 |, [ 11390 | |I

Adf / Nav / Com

nm hdo km freqg

| ||39“|'"ﬂ“t:|
XPN | 7000 | -

TT-ATCCOM.ATC_M

Mem: 13993 mb

vor [ adf O rwy B wpt B Int []

\'J
= eEanmm 8

ATlasHold is never using Frequencies
for any automatic approach or else.

Selecting a IS Freq you see the lIs
Deviation on the Radar and HSI just for your
reference.

Selecting a Wpt with a Freq that Freq
is copied into the Cockpit-Instrument.

You can approach in automatic any Wpt:
Rwy, Wpt, Vor, Adf without Frequency.

This is meaning that you could overwrite any
Freq that is saved when you select a Wpt.

The whole system is only working with real
world Coordinates + Mathe-Formulas by
'Ed Williams'.

U=
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Flight Plan x X-Plane

Departure EDDM | Rwy|8L 2.155 Select H
Destination || ERLE VOR ADF Intersection via Apt [ Virtual Wt —

Runway “ 5 5 5 s [ ] Rwy Approach | X
00Ca CGOLDSTONE GTS 3038 35 .350525 -116.888367
ooM THIGPFEN FIELD 351 31.553700 -89 234500
00R LIVINGSTON MUNICIFAL 151 30.685300 -95.017300
oowv MEADOW LAKE 6874 38.345400 -104.563500
00OWI HNORTHERN LITE 860 44 304283 -8%.050111
00XA WISEEY EANCH 271 30.22403%9 -96.014153
01G PERFEY WABRSAW 1557 42 741800 -78.043500
01ID0 LAVA HOT SPRINGS D268 42 .608250 -112.032461

An extensive and complicated flightplan is never the right choice.
In reality creating a simple Flp it is not always possible due to the huge air traffic.
Tons of Fuel could be saved.

Foom

! nm On - up dn Load FAp Save Flp

R-Click > Close

EDMP .

03

1/8

Read the ToolTips.

Place your Aircraft on a Runway start.
Departure Airport.

When selecting an Airport and a Runway
Destination this data is copied into the
Flight Plan only if there is no Flight Plan
selected / loaded.

In this way a Flight Plan is initiated.

The next page ends the Flight Plan with
2 Waypoints:

[virtual Wpt] at 20 nm in front of the
runway

[Rwy approach]

This is a simple Flight Plan.

When you select a Runway ATlashold
knows where the Departure Airport is and
asks for confirmation for the Apt + runway.

The Flight Plan Name is created in
automatic when you save the FLP.

The graphic display

* The Red Line is the actual Heading

* The purple Line is always pointing to the
virtual waypoint at 20 nm in front of the
Rwy. Here: x wpt, distance 18.3 nm.

Using the virtual Runway and the virtual
Waypoint you NEVER GET LOST !
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Flight Plan x F5X

Departure EDDM Rwny [ 261

Destination EDMP

Runway

O0CA
ooM
O0OR
oov
OOWI
O0XA
01G
011D

wpt
TWY

YVOR

COLDSTONE_GTS
THIGPEN FIELD
LIVINGSTON MUNICIFAL
MEADOW LAKE
NORTHERN LITE

WISKEY_ RANCH

PERRY WARSAW

LAVA HOT SPRINGS

Zoom

Range (50 | nm Om

2.155 nm

ADF

up

Select

Intersection

S
3038 3s5.
351 31.
151 ao.
6874 3s.
8&0 a4,
271 30.
1557 42 |
5268 4z .

dn

350525
953700
685900
245400
304283
224033
741800
608250

EDDOM-26L-EDMP-03

H
[x] Virtual Wt Exit
[x| Rwy Approach | X

-116.888367 "

-89 .234500
-95.017900
-104 .56%500
-89.050111
-96.014153
-78.045%500

-112.032461 W

Load Fp Save Fp

R-Click > Close

2/8

Read the ToolTips.
The last Wpt is the [ Rwy] Approach.

The [ Rwy] approach is only leading you
to the Runway but this is NOT the V/S Rwy
approach that is approaching the runway
following the GLIDE SLOPE descent
procedure.

The [V/S Rwy] approach is selectable on
the big Radar or Joystick or Keyboard.

Selecting Landing is your Pilot choice.

Example: Don't select any Flight Plan.
Place your Aircraft on Rwy 26L EDDM.

Flight Panel View: select Apt EDMP
Click on Rwy 03 and follow the messages.

Now your FlightPlan is copied into the
Flight Plan View.
Now select [x] Virtual Wpt and [x] Rwy.

Select the V/S distance to 4000 feet in
big Radar > near [Runway].

Take Off. (Gear, Flaps) then engange the
[ VIS Dist ]
Start the Flight Plan. [ flp ]

Flight Plan > Free Flight:
(just use the Fly_to Buttons:
[ wpt]then [rwy])

When the Glide Slope (Diamond) is
centered engage [ V/S Rwy ]. DON'T
miss that moment.

You do not have to Save this Flp.
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Flight Plan x X-Plane Read the ToolTips.
Dieparture LOWG | Rwy|35C 1619 nm Select H This is only a Wpt-Test Flight.
Destination | [EeYRL VOR ADF Intersection via Apt [ Virtual Wt Exit
Runw S S 5 5 Rwr h | X . s g .
sy =] L s For using a Search List first click on the

DOCA GCOLDSTONE GTS 3038 35.350525 -116.888367 ~ | specific Label. VOR, ADF, Intersection .....
DOM  THIGPEN FIELD 351 31.953700 -89.234500
DOR  LIVINGSTON MUNICIPAL 151 30.685900 -95.017900
DOV ~ MEADOW LAKE 6874 38.945400 -104 569500 The Runway Lenght for both, departure and
EEE LDE:;EHE,R%;;IZE 2:2 ;; ' 22:223 :Ei ' Efii;; arrival, is used for the Runway Take Off and
01G PERRY WARSAW 1557 42 741800 -78 049500 Landing Panel.
01ID LAVA HOT SPRINGS 5268 4% 608250 -112 032461 v
int XANUT 47.116269% 15.311881 Load FI
apt LHSY SZOMBATHELY 732 47.282500 16.626389 [ Pl . ]
int SOPRO 47.587778 16.802500 several Test Flight Plans are included.
wBE Crossing the xWpt the Glide Path Slope is activating the Descentometer.
- Consider it only if you are on the right Rwy-Course ! If you want create a new Flight with

Zoom the Flight Plan you must first deselect
Range (80 ~ nm On |71 up | dn LOWG-35C-LOWW-34 Load Fp save ip | the active Flight Plan.

This is done using the Button
LD'II."J“I."!
R R-Click > Close [X].

Then [Flight Panel] > [Apt's]

If by chance a wpt is not
. performed stop the [ flp ], mouse-
Version 2.0.2 FEB/23 O LHSY (51) click the next wpt and reopen the

The Big Radar is now evidencing 2 waypoints: Flight Plan [ flp ]. Big Radar >
- the selected Flightplan Wpt ( XANUT ) F|ight Plan List > See big Radar.

- the next (following) Wpt ( LHSY )
as reference for a Turn ecc...

Remember the correct use of
the Glide Slope Descentometer.
Never react fast during a final
approach.

Wait and see.
The Airplane is not a Ferrari,




F
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Runway Approach - Alignment- Intersections

*You should select a Wpt that is aligned with the destination Rwy with a maximum of 5° Runway-Deviation. Intersection, VOR, ADF.....
The Wpt selected should be some nm before the virtual Wpt or in any case 20 nm before the Rwy-Start.

First you must load the Intersections. Flight Panel > [ I ]. Click on a Item. Data is copied into the Flight Plan Field if no Flight Plan is loaded!
* Before Approaching the Rwy Alignment wpt select the requested Glide-Path Altitude. Radar > [ GP Alt ] x 10nm or 20nm Rwy distance.

You can select any different, Lower Altitude > The Glide-Path descending would start nearer to the Rwy.
* Now select / input the Flight ALT using the Radar distance selection [ 0 ...50000 ] feet in steps of 500 feet. (near the Radar > [Runway] Button)

Flight Plan x F5X

Depature | EDDM |Rwy(26L || 2.155nm | Select H Rwy deviation max 5° destination Rwy
Destination ADF Intersection via Apt [ vitual Wpt - | B | oo panel - Fox

Runway [ I[s s| [ ]ls| ORwaproach |x
MAD45 40 273 48.398847 10.814025 ~ EHSt‘_""“:E-lc'imI @I:I

MAD46 45 270 48_367183 10.673578 lcao rwy nm hda km freq Hev [

MARO47 35 284 48 525233 10.853381 Buy-Devy ° ~ fName/ Dist-To-Rwy /W E
MACAT 12 267 48 341522 11 . 496435 ~ [CF35C 7 »4E,8€€378

MALAB 79 290 48 826320 9. 951784 o - oMogn 7 -4¢ 337056

MAMOR 36 25 48.885834 12 222222 -

0 ~ GGERIZI0E T =4g 85818
MANAL 27 Non un numerc reale 47. 833353 11.800000 0 ~ LENIZ 11 >4€, T91EET
MATIC 72 101 48.058592 13.541495 v 0 - wWeool 12 ~46 786217 -
There is a difference between the 2 Intersection selections. 9 WEROZo 3 74€,835350
0 -~ WZOl4 10 =d4g 215€58
. i . 0 ~ WEOls £ =46, 885170
The Flight Plan Intersection (observe the Heading that could be useful) 1 GRZ1Z 13 *46, TSE25E E
- Search by Name — Input a Name - Example “Abruk” or “Abr” 2 PODET 43 +48,171375
- Search by Distance. Input a Distance (80). Distance is related to the destination Rwy. b e I onitE

The Flight Panel Intersection [ | ] selection (maximum Rwy deviation = 5°)

- Search by Name

- Search by Distance. Input 30 into the Distance Field. Default = 50 nm.

- You select 073MR that is aligned (4° deviation) and behind the virtual Wpt (20nm) at 39nm.
The selected 073MR Intersection Name is copied into the Flight Plan Intersection Field for
your Flight Plan use. Here, each distance is relative to the Rwy!

[ o]

* Or use the Radar [ Vor/Adf/Int ] Button. Read the Tooltip and select + copy into the FLPL Field.
- L-Click on Radar, select the distance to the Rwy (MouseWheel). You get a better visual view. Ed -

g
Y
vor [ adf 3 rewy 3 wpt 3 Int -m
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Departure LIME | Rwy|32 1,342 nm Select H
Destination [ ESIHE VOR ADF Intersection via Apt [x] Vittual Wpt =
Runway 5 5 5 5 [X] Rwy Approach X
00CA COLDSTONE GTS 3038 35.350525 -11&6.888367 ~
ooM THIGCFEN FIELD 351 31 .5%53700 -89 . 234500
OOR LIVINGSTON MUNICIPAL 151 30.6855900 -95.0175%00
oov MEADOW LAKE 6874 38.545400 -104 .565%500
0OOWI HNORTHERN LITE 8e&0 44 304283 -8%.050111
00Xa WISEEY RANCH 271 30.22403% -96.014153
01G FEERY WARSLW 1557 42 741800 -78.049500
01ID Lava HOT SPRINGS 5268 42 608250 -112 . 032461 b
int LAPHNA 46.5354597 15 520431
wpt
EWY

Zoom
Range 50 ~ nm On - up | dn LIMB-32-LOWG-35C H Load Fp Save Fip

R-Click > Close

LOWG -
B/C

Change the Main TimerSpeed.

Selectthe Timer speed in milliseconds ?
Default=200ms. Pls. read the explanation!

When terminated CLOSE. (click on the Label [.]).

5/8

The Timer Speed

Bottom Left corner. There is a very
small Label with a point [ . ]

The Timer speed affects both the
program and the Joystick.

A value of 150 ms is acceptable.
Less than 150 ms is only depending on
your System.

Below 150 ms the Joystick response is
very fast.

A too fast response could influence the
KBD-Connection!

Try it.



Flight Plan x M5F5

Depature | LJMB | Rwy|32
Destination

Runway

0DoOCA CGOLDSTONE GTS
ooM THIGPEN FIELD
O0OR LIVINGSTON MUNICIPAL

oov MEADCW

LAKE

0OOWI HNORTHERN LITE
00Xa WISKEY RANCH
01G PERFRY WARSAW
01ID LAVA HOT SPRINGS

adf EW 47 .1598056

|| 1.342nm |

14 _THEE6E6T 418

apt LOTK LANCEAMPFEN

L wvor LAB 48 .
.218042

adf LUP 43

p|int DME14 48.
.315661

int DM430 48

065333

285617

10.880833 112.15
9.9210872 407.00
10.765858
11.177758

Zoom

Range 200 | nm |On -

R-Click > Close

Select -
Intersection [via Apt | [:l Virtual Wit Exit
COE CE COE CE Do 3
3038 35 .350525 -116.888367 Y
351 31 .553700 -89 _ 234500
151 30.685900 -95.017%5%00
6874 38.5%45400 -104 565500
8ea0 44 304283 -85 .050111
271 30.22403%9 -96.014153
1557 42 741800 -78.049500
5268 42 608250 -112.032461 W
.00 :EZELTWEG L
1588 47 564167 12127500
: LANDSBERG
: LAUPHEIM
W
up dn LIMB-32-EDDM-08L H  Load Fpl Save Flpl

Version 2.0.2 FEB/23

The Big Radar is now evidencing 2
waypoints:
- the selected Flightplan Wpt ( ZW )
- the next (following) Wpt ( LOIK))
as reference for a Turn ecc...

Glide Path Slope

T D
2l (58]

Kbd
On/Off

Info

Rermember:

The Flpl List [tems are starting with zero (0.

5o, the 2nd item = Index 1

Control the correct Rwy Approach on big Radar.

From xWpt (virtual Wpt) before RWY  To RWY approach

FLPL with 2 waypoints > wpt + rwy
The correct final data after heading from wpt to rwy:

= Wpt-Hdg Any Wpt - Apt-Hdg, Ver-Hdg, Adf-Hdg ecc.....
= Index Mr. for any wpt ltern
= Wpt Idx: 1 Only virtual Wpt fly-to + Index nr.,

= Ry ldx: 1 Intersection” info or Rwy + Index nr.

Flight Plan Control
OBSOLET - not used anymore

Toggle button

O
> Key edit. If closed > only reading not executm+

Version 2.0.0 Nov/2022 6/8

Flight Plan interruption.

* When you interrupt a flight plan
the plane is continuing and
therefore when you return to the
flight plan you have to consider
whether the plane is in front of or
behind the waypoint before the
interruption.

Change the waypoint item.
(click) select a Waypoint (Flight
Plan or Radar) Item and then
close and re-open the flight plan.

* You could also fly back and
repeat a different fly section.

Flight Plan Control. Read the Readme File x version 2.0.5!



Flight Plan x MS5FS

Departure LIMB Rwy (32
Destination EDDM VOR

Runway
00Ca GOLDSTONE GTS
OoM THIGPFEN FIELD
O0R LIVINGSTON MIMICIPAL
oowv MEADOW LAKE
O0WI HNORTHEEN LITE
oO0xXa WISKEY_RANEH
01z PERRY WARSAW
011D LAVA HOT SPRINGS
adf EGG 48 397050
F int DM44%9 48 388450 12 . 395345
i et
WY
F|

Foom

Range (200 ~ nm On

GlidePath

View the actual Joystick + Keyboard setting.

1.342 nm Select
ADF Intersection |via Apt |

5 5 S
3038 35 .350525
351 31.953700
151 30.685300
5874 38.945400
860 44 304283
271 30.224039
1557 42 T41800
5268 47 608250

12.745781 393.00 :EGGENFELDEN

- up dn LIMB-32-EDDM-26L

MSFS.ini

R-Click > Close
[Shift]

1
[RunwayHeading]
0
[WaypointHeading]
0

[VirtualRunway]
0

[ALT Autopilot]
4096
[HDG Autopilot]

steelBlue
ghtBlue

Info

Actual Joy + Fbd S

roarreardy

Black

(] Virtual Wpt Exit
[ ] Rwy fpproach X

-116
-89
-95

-104
-83
-96
-78

=11z

.234500
.017300
.B&3500
.050111
.014153
.043500

H Load FApl Sawve Fpl

Position xy Click

All Views LOC Pasition

.BB8367 ]

.032481 W

7/8 E

ATlasHold 2.0.0
Nov/2022

Flight Plan

A quick overview.

View your actual Joystick + Keyboard
Mouse-Clicks.

Reset all Views to the Default Position.



Flight Plan x F5X

Departure LIMB Rwy (32 1.342
Destination LOWG VOR
Runway 5
00Ca GOLDSTONE GTS
00M  THIGPEN FIELD
O0OR LIVINGSTON MUMNICIPAL
oowv MEATIOW LAKE
O0WI HNORTHEEN LITE
00XA WISKEY RANCH
011G PEERY WARSAW
01ID LAWVA HOT SPRINGS
Zoom
ji[s]f] Fance 30 ~ nm On -

. [.]Timer GlidePath Slope

Quick overview > | Actual Joy + Kbd

ADF

LOWG,.
35C

5

up

Select -
Intersection [via Apt| L] Virtual Wpt Exit
S 5 [ ] Rwy fpproach X
3038 35.350525 -116.888367 ~
351 31.953700 -89.234500
151 30.&685500 -85 .0175%00
6874 38.5%45400 -104 5659500
ae0 44 304283 -8%.050111
271 30.2240339 -96.014153
1557 42 741800 -78.049500
5268 42 &08250 -112 032461 W
dn H Load FApl Sawve Fpl

R-Click > Close

i Light SteelBlue

- MidNight Blue
DarkGray
Black

Position xy Click

All Views LOC Pasition Reset

8/8 F

ATlasHold 2.0.0
Nov/2022

Flight Plan

Menu overview.

Read the Readme File x version 2.0.5!

all Views to the Default Position.




ATlasHold 2.0.0 Nov/2022 - Big Radar - 1/9

Prepare the Flight Plan — On Ground

ATlasHold Radar x F5X Read the Readme File x version 2.0.5!
Range m A mGd FER| me-32owcasc [[rors Al 8371 (KETISMZSMGTKasenst N 202 2= | 0 e 32,1 | VOR X [N T
+ 0 360
0 570 (89) ILS Marker. O, M, |
Oy - WGM (90) ) moom
© LNz (92) © FMD (82 R-Click > Close
On Air with a Flight Plan active you can stop/interrupt the FLPL. O SNU (63)

Free flight is now possible.
L-Click > Mouse Wheel > Zoom
Use the [ Vor/Adf/Int ] Button. Only for VOR + ADF.

Read about “ FREE Flight “ ON Ground
s . S _
On AIR > when you click into the small circle the ngt;:tig;r;ﬁt(:;ﬁf FLSIflle;iteld

airplane is flying in automatic to this VOR or ADF Wpt.
You can add to your Flight Plan.

- LOWG
270 Loy . %
G\l (65)
2 KFT (43)
C DoL (61
O 706G 7%
0 1za (80)
Select VS Distance 180 GP Alt

L W Runway B {fip | 200 1000 | [Spoiler40% | » 2% 1 wsose | wsrey |
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Prepare the Flight Plan — On Ground

Range ma med [  ve-iowe  [faors]ar 879 [D7MR N 252 2- | 0 [ee 32,1 [ INT
+ 0 360

Intersections must be first selected / loaded

Flight Panel > [ 1]
R-Click > Close

Read the ToolTip

L-Click > Mouse Wheel > Zoom

INT copied into the FLPL Field.
You can add to your Flight Plan.

LJMB = x\wipt { 13) = wpt (20) x

Dewv Distance Hame Latitude Longitude

10 nm  WcO014 46, 819658 15, 486658 |

11 nm  LENIE 46, 791667 15, 495000

12 nm  WCOO1 46, 786217 15, 495795

13 nm  CRE1Z 46, 758286 15, 499472

49 nm  PODET 46,171375 15,626797 C3D?3MH(3$

27 nm  LADNA 46,535497 15, 520431

3% nm  D73MR 46, 331845 15, 564200 kg 180 GP Alt

[ P Runway NS | fip I Spoiler 40% [e PN %5 |:| B 1) vsois | wshwy _
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Prepare the Flight Plan — On Ground

ATasHold Radar
rong: RN W A+ M Grd [ wme-rowc  [aos|ar 579 |[PISSEESEI2SRsamvina i 353 3- | 0 (e 32,1 ||ADF ¢ n) T
+ 0 360
R-Click > Close
Select > “TUN (83) L-Click > Mouse Wheel > Zoom
o Lz 38) 9 STE(81)
ek ; WO (81
Click into the small Circle ¢ E,RK &3 ADF copied into the FLPL Field.
You can add to your Flight Plan.
CTF(62)
G pc(87)
S eem)
Y VR (89)
C Zw (31)
270 LOWG 90
3BC &
GRZ (3L gpg (16)
© SME (73)
] \
KV ey H}tﬁ 4:=~3i<‘u’.'pt (13) > rwy (20)
© M (33)
o
MR (33) © VAR (56)
© MG (61
NE}&AI‘E# (61)
D ZAG (74)
© SK (7 N The T
o ew — The Turn
o VG(79) Read the Tooltip
MEL(80) Opjg(34) Explanation.
4620 ft at 10nm >
Select VS Distance 180 O GP At

| B Runway | m | fipl || 3 | | ||Spoi|er4[]% ] ot I:l 1 ‘ VS Dist. H VIS Rwy | _
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The Flight Plan View Options

Rance ERd B 4 mGd RO (oveso-eoomost |[fAoslae 879 e W Adf 3233°| 0 o 1957 [ % [v] v
{4+ 0 | 360

R-Click > Close

L-Click> Mouse Wheel > Zoom

EDD
T(211.4)

270 10 @ 90

las Speed Input Field

Set AP las Speed
Open on Rwy Landing View
[ spd ] button.

150 =
58 nm adf ZW 418.00 : ZELTWEG , - o New — The Turn
109 nm apt LOIK LANGRAMPFEN 1588 AJ + Open L h Slope Editor) Read the Tooltip
g 59 nm wvor LAB 112.15 : LANDSBERG Explanation_ 2487 ft 3t 20nm = |
40 nm adf LUP 407.00 : LAUPHEIM 0 GP Alt

em. [Kbd] button.

Vor/Adf /Int m | E] || Bl =poiier 4U% i s I:I 1 ‘ WIS Dist. H ViS5 Rwy | _
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The Descentometer

Range 200 ~ B Ar H God EDDM-DBL Ht ﬂ?g It i YVor Adf 323.3D U, Wy 195’? Dx
+ 0 | 360

Automatic Descentometer

You Set the AP ALT value. Read the Readme File x version 2.0.5!

IMPORTANT

Don't fly full speed! Reduce to about 60 te 70% total engine pressure,

The aircraft V/5 systern is not supporting heigh speed.

Check if the Descentometer is really ascending or descending.

If you notice a failure reduce the speed and activate the Aircraft [ VS ] if present.
This has nothing to do with this software!

For X-Plane + M5F5 you should " Toggle " the AP "ALT" using the "ALT" Buttons as explained.

This is necessary becouse this Simulators are not responding correctly. We must "Free” the AP Altitude “ALT".
Also several Arplanes for this 2 simulators are not responding correctly.

Click the Autopilot ALT > Main View or Joustick or Keyboard settings,

With no ALT indicated / selected V/5 is using the Default ALT of 10000 feet.
(interrupt the W/5 Decentormeter » click on th [V/5 Dist.] Button,

270 Descentometer is reading the Autopilot Altitude " ALT "
L-Click > Mouse Wheel > Zoom IMPORTANT - _ _ ,
Input the desired Altitude into the [Dist nm] Mumber Field]. (Flight Panel)
ar
R-Click > Close Use the ALT Selection near the [ Runway ] Button, Step 500 feet, Read the ToolTip.

Get the Rwy-Approach ALT

Get the final Approach ALT at 10 or 20 nm distance from the Runway 5tart. Button > [ GP Alt ]
Then use the ALT Selection near the [ Runway | Button.

The Blue-Circle range is set to the Distance calculated.

The V/5 speed +/- is calculated in automatic.

Change distance (V5 value) to reach the desired Hight-ALT, Use the " blue " circle range selection box,
Left-Click » close the automatic Descentometer.

Always control your Autopilot. Autopilot (AP) controls like ALT, HDG, &P, V/S must be on or off depending on the "Selection”.

ATlasHold is doing the AP-selection in automatic but " ADD-Ons " might be different.

You can select a Joystick or Keyboard command for this selection,

Vor/Ad /i ol (N JLSpoiler 40% | 5 132 P R T 0



ATlasHa 0.( ' Rac : =
D s
A mGd (US| Lome32-eoomost |[[Aos]ae 879 ek Vor Adf 3233°] 0 |e|195,7 [ % E T
| | 360
]
L-Click > Mouse Wheel > Zoom
R-Click > Close
EDD
f(211.4)
| i
| 270 10@ 90
las Speed Input Field
Info Set AP las Speed
Set the Distance Altitude ALT in s Open on Rwy Landing View
[ spd ] button.
Value is c 150 =
Useitin
New — The Turn
58 nm adf ZW IHh .
109 nm apt LOI Read the Tooltip
I I Explanation.
a :4'; o V:;f E’Iﬁ P 8487 ft at 20nm > |
nm_a GP Alt
180 0
Vor/Adt/Int M spoiler 20% | s BEEVEESR SRR 1 || vsoise || vsrey [SCIE




Range

m A mGd [URE| Lovss2eoomos |[fAecs]ae 870 It Vor

323 3° 0

W 195,7 L%

[n]

+ 0 |

EDD!

it (211.4)

1 270

Info
L-Click =

is selected Fly-To,

e the FlightPlan + Re-Open the FlightPlan [ flpl ] buttons.

R-Click on the ListBox. The vertical Bar is opening or ¢

58 mm adf ZW 418.00 :ZELTWEG
109 nm apt LOIE LANGEAMPFEN 1588 Alt
m 3% nm wor LAB 112.15 LANDSBERG
40 nm adf LUP 407.00 LAUPHEIM

360

The

mathematic

180

Vor/Ad /it 12000 2

usting the Height in auton

centometer is

R-Click > Close

L-Click > Mouse Wheel > Zoom

]

Altitude "ALT".

tic, Depending on the dist

utely precise but not all Airplanes are including a perfect

|wsnis:. || VIS Rmy
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Read the updated ToolTips

IA‘I’IasH-:-Id Radar x F5X Read the Readme File x version 2.0.5!

s ENRG B4 W G [rocsJAl 6502 il o0 0 BAEY 00 I 256 | 167 o] 16,2

* Range: is selected in automatic based on the Dist To Destination (1 to 3000 nm).
- Can be selected only when the [ Apt's ] Listing is selected. L-Click then use the Mousewheel. See >Troubleshooting

*[]1Air +[] Grd: in use with FSX, MSFS. Air + Ground traffic.

‘The Blue Circle Range: [V/S Dist] Descentometer is calculating in automatic the Range (nm) based on a smooth V/S. 3 T |
You can select a shorter Distance but be careful. If you exaggerate the ascending is changing into a Negative V/S (Engine Power limit).

During flight, on cruise, you can select a circle Range and using it as a visual distance reference. See > Troubleshooting

[ Apt's ] : Airports and distance are visible within the selected [Range]. On the right side a [ L ] Label is opening.
The L-Label is opening the Airport List including all Airports within the Range selected.
Selecting 1 Item the ICAO is copied into the Flight Panel Icao Field for direct access.

* Int, Vor, Adf: When selected, FLP flying to, the distance is indicated. Also visible on the TakeOff + Landing Panel.

* Rwy: During a Runway Approach this Label is evidenced with a Red Background color. Indicating the direct distance in nm to the Rwy.

*[ Kb ]: Now there is a new Label. Keyboard connection on / off. (in place of the [H])

*[ N ]: Map oriented or North oriented.

[ T] : Stay on Top. With the red color stay on top = Off.

* Below the Range-Label: > 16 is indicating the Wind-Direction and Value.

» Below the 360 ° Label: any course and Runway Center deviation is indicated with a Yellow or Red Color Strip. The width is the deviation value.

* Right Side of the 360° you see the Glide Path Slope that is opening at a 20 nm distance from the Runway.
It is important to read the Glide Slope correctly. Here the indication is “too Low” = go Up. But when we approach a Rwy you can't get Up while the
Airpline is moving forward.You should wait until the ALT is moving the Glide Slope (Diamond) to the Center, then engage > [ V/S Rwy].
Only in a dangerous situation you must correct the ALT.
While otherwise the Glide Slope goes down we have to follow the indication and go down because we are too high.

It is never wrong to keep a slightly higher ALT for a free flight or use the >>>
automatic Glide Path approach [ VIS rwy ]
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Read the updated ToolTips

* [ Vor/Adf/int ] : Select/Show all Vor, Adf, Intersections display on Radar at a distance of [ Range ] related to the destination Runway only.
R-Click into the small circle. Data is copied into the Flight Plan Field by Name > [S]earch and select. Intersections must be loaded first!
See Radar page 2/9

* Runway Display: Open/close the Runway TakeOff / Landing View or use the ShortCut. Read the specific page [Runway Take Off and Landing View].

+[ 10000 ]: Select the Flight ALT. From 0 to 50000 feet, step 500 feet. Value is copied into the Flight Panel Distance Field. Used by [ V/S dist ].
Avoid the manual Input. Refer to [ GP Alt ] on this page that should be used only as reference. Your choice should be LESS !

* [ flp ]: This button is activating the Flight Plan L-Double Click. R-Click open the Flight Plan View. (color yellow = Flight Plan selected)

*[ 2000 1000 ]: Open/ Mark the RAD distance only when the ground is less than 2000 feet below. Similar to the Aircraft RAD alarm at 1000 ft. It is gradual.
Ground Proximity Warning System is active.

* [ Spoiler 40% ] (60%) L-Click set Spoiler to 40%, R-Click retract Spoiler to “ 0 “. 40% with smaller Apl is setting 60%.
* The small green light is a additional alert, the Brakes state = On
* Nose Gear: Visible with the Gear extended.

*[ Lat/ Lon ] Button: Indicates the latitude and longitude of the precise position in which the airplane is located. The program ADDAirports is using it.
46,473908 — 15, 691928 It is very important to verify any World location I|ke Alrports Runways ecc.. ATIasHoId is only using real world Mathe formulas.
irtual I I t . .

*[1]: (0..5 nm) Default is 1 nm. At Any Waypoint, Vor, Adf, Int, Rwy, Apt ecc... The automatic fly ends with a acustic signal. The Turn is starting.
The type of aircraft and the speed must be taken into consideration for a reasonable choice.
As the plane proceeds the Turn begins. For example, if a Adf is close to the Mountain and the next Wpt is on the left, perhaps we will chose
the distance of 5nm. Example: ADF " RTT " before the Rwy Alignment to LOWI. Depending from which direction you approach.
Read about the new “Turn” selection. "Radar Turn selector.”

[ VIS Dist. ]: Activate the Descentometer. First we have to indicate the height in the "Distance" field in the Flight Panel. (distance Fleld)
Before you engage the [V/S Dist] make sure the Airplane Asset is stable. Circa 10 to 15 ° Horizon. SLOWLY Release the Yoke.
(This is a most common Pilot Error) Make sure the Autopilot + ALT is ON. Read the TroubleShooting about this important argument !

[ GP Alt ]: It is used to determine the precise ALT for a Runway Approach which is used for a gradual descent. (the green value)
L-Click is returning the ALT for a Rwy approach starting at 10 nm. R-Click is returning the ALT for a approach starting at 20 nm distance.

*[ VIS Rwy ]: Enters the gradual descent along the Glide Slope line. Start only with the Glide Slope (Diamond) centered. The Pilot is responsible for
maintaining the required asset such as Speed, Gear, Flaps and Trim. The right Flap setting is important for any aircraft!

With the right asset as per instructions the plane lands without problem and without any Joy X / Y Axis intervention.
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The Turn selection xXWpt - Rw

Rance LR H A mGd R  ome>iowc  |[ass]ie 879 e Vor Adf 3233°| 0 [0 32,1 [% E T
+ 0 | 360

LOWY
35C

wpt (1

[0]

[1]
i 270 10 90
| [1]

Start the TURM

The 5t

[0]
Info

Angle in Degrees between Actual Heading + any selected Wpt.

2 nm

ach 1nm before reaching (start the Turn) any Wpt.

nm) turning to the virtual w int (x wpt) or Alignment you should reach the Wpt with
a maximum speed o i

Consider the degree Angle for your cheoice. (above this selection)

180 U GF Al |

ma 3 || M Spoiler 40% N5 BREVFE 1 || wsois || wsewy | [

Vor/Ack /i o B
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Read the ToolTips

Small Radar

[V/S Rwy] is selected. [ A] is opening the Airports View. Distance as per Range setting.
Map is North oriented. [ VIS ]is active.
Glide Slope is requesting to decrease ALT. Within the Blue circle the “half circle” is indicating the descentometer progress.

ATlasHold Radar x X-Plane

R-Click > Close = EDML (12}

EDMP
03 EDMI

L EDNX (15)
C EDMD (20) )

% wipt (13,6)

V/S Rwy |+ 200 - Vs Rwy |+ 200
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The Approach Precision Radar

This precision Radar is opening
at a Rwy distance of 20 nm.

Click on the [ Rwy ] Button
or use:
- Mouseclick xy connection
- Joystick + Keyboard connection

Keyboard > Mouse Click connections

Read the ToolTips

Approach / Landing Radar > Flight Panel [ Rwy

‘Flight Panel - X-Plane

Joystick Connections

|
Distance - Fad l] |ﬂ
ADF =

20 nm Range 03° | 028° E
EDNP

03 R-Click > Close
1450

HOE

o A28

26

I.fn:lr T adf 3 rw B wpt =3 Int

W] AB6/29°

Initial / actual fly to and distance
Runway approach

* to LOWK fly 302° / 12,8 nm dist.

*to VOR fly 335° / 5,2 nm dist.

«to RWY fly 283° / 8,9 nm dist.

« to Virtual wpt fly 75° / 8,9 nm dist.

* Rwy deviation -12°

» Approach ALT -108 feet = too high

* Glide Slope Diamond “Apl too high”.
High = too Low. Low = too high.

i The Airplane Rad-AGL

The latest versions are a bit different.

Airport + Distance | Fly-To / Fl
L 206, RN 3002 | os | 349

ADF [ » | 34

R-Click > Close

103° | Rwy Badial -10.1
vor 1 adf 3 rwy EE wpt O3
Ml AB12302 |ACS5a3 N B
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Runway Take Off + Landing View

Open using a ShortCut, Joy, Kbd or Click on the dedicated Button on the Big Radar. [ Runway ]
The Runway View is very useful during night. You see where you are on the Runway and the lateral deviation.
On the Air important Flight data is displayed.

On Ground and On Rwy touch down the Rwy graphic is opening.

TakeOff and Landing Rwy-Display x FSX Read the Readme File x version 2.0.5!

_1.342|135C | 1.619 0 |J3233 M 879 | 321 | 00% | 00° e
- Departure Rwy name ID spd ’—‘

- Departure Rwy Length in nm
- Destination Rwy name ID
- Destination Rwy Length in nm
- Runway graphic with Aircraft position. On Rwy + Rwy touch down. Total length / Length left. Less 20% left > Red color warning.
On the Air the actual Waypoint (Vor, Adf, Inters., Apt, Wpt ecc..) Distance is visible in place of the Rwy-graphic.
- [ las ] Aircraft speed in Knots / Groundspeed / Kilometer (Click)
- [ spd ] Click (on/off) > Set the Autopilot AP Speed using the MouseWheel. This View must have the Focus Or use the Input Field on the Radar.
- [Kb] Keyboard on/off sign.
- Actual aircraft heading. Click and open the Flight Plan List > "FlightRoute”
- Actual ALT > Feet / Meters (Click)
- rwy > DIRECT Distance to Destination Runway
- Engine Pressure (all engines). If not activated then click on the [ A,N,I ] selection below the PFD Instrument on ATlasHold Main-View.
- Trim position
- PFD Horizon Instrument. Indicating Bank + Rwy-Deviation + Rwy-ILS-Deviation
- The Autopilot buttons: AP, ALT + ALT-Lock, Heading
- Rwy approach Glide Slope + Diamond position U/D is opening when Rwy-Hdg.
Read the new Glide Path Slope View > opens on “Flight Plan” >
- Flaps position (over 50% color red)
- Ground Proximity Warning System. Active below 2000 ft AGL.

Descentometer opens on Rwy Heading.

Remember the correct use of the Glide Slope Descentometer. FSX — Trim Value is evidenced + Joystick OK.

. The Glide Slope is opening at 20 nm Apt-Rwy distance. X-Plane — Trim Value i_s not vis_iblg BUT the Joys_tick Butt_on Trim u_p/dn is working.
2. If the aircraft does not follow the route runway the distance Some Apl like the Citation CJ4 v 1,07 is returning the Trim Value.

could be much less. With [V/S dist] + [ VIS Rwy ] Toggle the AP ALT-Altitude before.
3. Consider the Glide Slope only if and when you take the runway
course and the actual ALT is moving the "Diamond" into the

—

MSFS — Trim Value only visible on Ground with the Autopilot OFF. (is a MSFS Bug )

center. With [V/S dist] + [ VIS Rwy ] Toggle the AP ALT-Altitude before.
4. Simply approach the rwy at a reasonable distance or via the
virtual xWPT. Nota: The Trim value is visible on the small ATlasHold Main View.

R-Click on the [ ET / AT ] Button. Now the Trim Mouse-Wheel is active. FSX only.
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The Flight Route

32 1342 ZW adf distance ; 94 |:|312,2° i 10914 \88 172,6 | 100,0% | 83"

49 nm adf ZW 418.00 :ZELTWEG

Open the “Rwy Take Off and Landing View”.

L-Click on the “Heading” Field. (toggle on/off)
The Flight Plan List is opening. Same use as the Flpl List on the big Radar.

L-Click on a Item. You change the “Fly to” sequence. Close the Flight Plan + Re-Open.
R-Click close



F
ATlasHold 2.0.0 2022

The Virtual ATlasHold Waypoint
You never get Lost

For any real Rwy, or Virtual, you select a virtual WayPoint is created at a distance of
20 nm in front of the Rwy you can fly to in automatic.

Distance in nm is indicated.
For any approach you can fly to this wpt in automatic; then turn to the Rwy.
Now decide for the final approach.

The correct wpt enter-angle should be max. 45 °.
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The Virtual ATlasHold Runway
You never get Lost

With one click create a Virtual Runway on Air, Ground, Carrier and return to

Create a Virtual Runway on the Fly just with 1 Click. V-Button Flight Panel - FSX
You create a virtual Rwy exactly on the coordinates where the Ostance [ o= o |
Airplane iS lcac rwy nm hdg km freqg Bev T
SCHOMEFELD >*hdg 3457 E
. . EDDB ** 33z 615 |
For example on the Sea. Fly and return exactly to this virtual
O7TL o6& 110.70 52
runway' Z5R 246 10%.50 52|

All functions are considering this Rwy like a real Rwy.
Fly to the virtual Waypoint at 20 nm and approach the Rwy.

The Rwy Elevation is exactly the difference between your actual
ALT and AGL to the Ground.

Remember the correct use of the Glide Slope Descentometer.

£

1. The Glide Slope is opening at 20 nm Apt distance. vor B adf B rwy B0 wpt == Int [
2. If the aircraft does not follow the route runway the distance could be A-B 332/245°
much less.
3. Consider the Glide Slope only if and when you take the runway course and e ort Information Center
the actual ALT is moving the "Diamond" into the center. L-Click > connect to " flightaware " world apt information

R-Click = connect to " SkyVector.com”. World Apt's + Charts,

4. Simply approach the rwy at a reasonable distance or via the virtual WPT.
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Virtual Rwy View — Save / Select
Virtual Runways

2/3

[VIL-Click (1)

Flight Panel - F5X

[V ] L-Click or R-Click LoWG FSX 35C stnce [ 0 E0oM |1 [ 195
15'4423[]2 lcao rwy nm hdg km freqg Hev [T
34;; **% Virtual Bunway ***
ToolTip 1115 * % % VIET * ok
|: 1 | 2,8
KMHT_FSX_06
L-Click » Create a Virtual Runway at this Positien, 42 929528 i
Virtual Wpt xwpt is set at 20 nm in front of the virtual Rwy. -71.447522
L8 N
Fly and return to " xwpt " = " RBwy" 266 -
Use only the Flight Panel " wpt " and " rwy " FlyTo commands. -15.8 R

(2} at your choice

o 4=

R-Click
Open only the Virtual Runway View and:
- Save this Position as Virtual Runway and then select
ar

_c = H . Ay Wi ] way
Select a different saved virtual Runway Sclact Ry Delete Rwy

MOTA: < b
—==== vor [ adf O rwy BN wpt B Int Dm
You can't select a saved Destination Rwy without passing the Step (1) ! \YJ

I-llii -

Save Exit




[ V] L-Click or R-Click

ToolTip
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3/3

The Virtual ATlasHold Runway
Virtual Rwy View — Save / Select

With one click create a Virtual Runway on Air, Ground, Carrier and return to

LOWG_FSX_35C

46.981339
15.442302

[V ] Virtual Runway - give it a name you remember

Any virtual Runway has the virtual waypoint "xwpt" in front at 20 nm distance

If you are sitting on a Aiport Runway choose the Airport ICAO as Name.
Same Airport + different Rwy's chose the Airport Name +"_35C" as example.

For any different position choose short names you remember.
Different Simulators > Different Runway and Position Data

Name Example: LOWG_MSFS_34C or LOWG_XPL_35C or LOWG_FSX_35C

Name Example: 777Sea_XPL

X 346
1115
2.8
KMHT_FSX_06
42 929528
-71.447522
58
266
-15.8

oK

Mame

Selected

(2)

oot

Save Exit ‘

Fﬁm-m:mm m s

lcao  rwy Bev LT

o o A '|~'|'

nm hdo km freqg

E  E

wy Heading: 346°
v Elevation: 1115

xwpt at 20nm at 180°

MagVar: E 2, 93¢ A
Fl
L
Distance Km: &0 F

Distance Nm: 32

Free

Flight >
Only

Approach:

[wpt]l + [rwy] Btn !

VorfAdf/Int] Radar X
i

£ >
vor [ adf O rwy BN wpt BB Int [

V
— El . |
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The Manual Fly to Selection

A Flight Plan selection is using the Waypoints in automatic. >>> Free Flight

Flight Panel - F5X

Without Flight Plan:

Distance [ =0 o |

- Flying to the virtual Wpt is requesting the [ rwy ] selection after lcao rwy nm hdg km freq Hlev
arrival at the Wpt and/or at a reasonable distance to the Rwy. e IH
The virtual Waypoint is always a precise heading reference. ol e loaen EEI

-The [ VIS Rwy ] Glide-Path Approach should be selected after the
Rwy-selection. Adjust ALT before and start the procedure with the
Glide Slope (Diamond) centered.

NOTA:

The Flight Plan is leading the Apl into the Runway-Path [rwy ] BUT this is not
like selecting the [ V/S Rwy] automatic Landing Glide Slope descending.

Selecting Landing is your Pilot choice and duty.

£

The VOR, ADF + Int(Intersections) are only used by the Flight Plan system. Fly to > r Eﬁ;‘? o s Ll

Fly without any Wpt selection (Free Flight).

The Virtual Wpt is then your main heading orientation.
For landing just use the Glide Slope indication, Radar or
the small Approach Radar on the Flight Panel [ Rwy ]. R-Click > connect to " SkyVector.com”. World Apt's + Charts.

Connect to a real Airport Information Center.
L-Click = connect to " flightaware " world apt information
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The Measure Data Selection
las, GS, Km, Feet, Meter
Autopilot speed

TakeOff and Landing Rwy-Display x M5F5

32] 1.342

LOIK apt distance 971 648 I:l.lz??.s“

Runway Position is opening On Ground

1342 35c || 1619

ATlasHold Radar x MSFS

Range mia mGd EERIR | 1 vb-52-coomosi | faers [ 12001 e . 2770° | 646

V) © o

Click — [ spd ] (on/off) > Set the Autopilot AP Speed using the MouseWheel. This View must have the Focus Or use the Input Field on Radar.

Click — las datafield > Knots > GS > Kilometer. Yellow = Km, Cyan = Knots, Salmon = Ground Speed. Same on Main-View “las” click.

Click — Hdg datafield > Open/Close the FlightPlan View. Fipl-View > R-Click > Close. Use it like the Radar Flpl List.

Click — Alt datafield > "Ft" Feet > "M" Meter.

Click — Alt datafield > "Ft" Feet > "M" Meter. Here you could select “Ft” and on the Rwy-Landing View “M”.

OO0« <

Speed. Yellow = Km, Cyan = Knots, Salmon = Ground Speed. No click. Select with the Runway View or the small Main-View (las).

n Destination Rwy. If you change any flight plan data on Air you must Re-initialize the Rwy Data. Click > Close / Re-Open.

c Select the Range for a better Radar View. Default is the Wpt or Dest-Apt Distance. L-Click on Radar > use the Scroll wheel or Range Field.

The blue Radar circle around the Airplane. Read the page: The Big Radar ( 8 )
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Glide Path Slope Editor

Flight Plan > [Glide Path Slope]

Increasing a Minus value (-300) means (+ ascending) and less descending.
The Default setting is leading you to the Rwy-Surface.

Enter only Minus values (-200). FULL 100 numbers.

Keep in mind the Slope Difference return value scale from " <10 to =60 ".
Only the Altitude Difference is considered. Too Low.

If you lower the values you increase the descent rate.

When you start the first time the Default values are loaded.
You can Input different values or select the suggested "+ ALT /++ ALT " .

[ SAVE |

Input errors are trapped and the default values loaded.

Speed and Flaps-setting is important. Don't fly too slow. ALT-Height is depending on it.

OK

ApproachALT

<10 [ B |
<20
<30
<40
<60 500
> 60 -600

Default

-200

-300

400

-500

600

600

+ALT

-300

400

-500

600

600

-700

Save

++ ALT

400

-500

600

-700

-700

-700
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BackGround View — 4 Colors

Light SteelBlue
MidMight Blue
DarkGray

Black
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Test Flights 1/3

KJFK-13R-KMHT-06.FLP

adf BD 41.877383 -72.766206 388.00 :CHUPP
int KENAT 42.644197 -71.854542

wpt

rwy

KMHT-24-KJFK-22R.FLP

adf BD 41.877383 -72.766206 388.00 :CHUP
wpt

rwy

LJMB-32-EDDM-08L.flp

adf ZW 47.198056 14.756667 418.00 :ZELTWEG

apt LOIK LANGKAMPFEN 1588 47.564167 12.127500
vor LAB 48.065333 10.880833 112.15 :LANDSBERG

adf LUP 48.218042 9.910872 407.00 :LAUPHEIM

int DME14 48.285617 10.765858

int DM430 48.315661 11.177758

wpt

rwy

YSSY-34L-YWLM-30.flp

int ENTRA -33.583056 151.696945
wpt

rwy
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Test Flights 2/3

LJMB-32-LOWG-35C.flp
int LAPNA 46.535497 15.520431
wpt
rwy

LOWG-17C-LJMB-14.flp
wpt
rwy

LOWG-35C-LOWW-34.flp
int XANUT 47.116269 15.911881
apt LHSY SZOMBATHELY 732 47.282500 16.626389
int SOPRO 47.587778 16.802500
wpt
rwy

LSZH-LOWW-29.flp

int DEGES 47.412500 9.201944
int XEBIX 47.400011 10.479875
int BADVI 47.731111 11.945381
int NEMAL 47.918056 13.498333
int NUBRA 47.866667 17.500000
wpt

rwy
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Test Flights - Aircrafts 3/3

Read the Troubleshooting page

The LUMB-32-EDDM-08L.flp is including all Flight Plan wpt's + a long distance.
You have time to check all the features, Apt's, Vor, Adf >
Interrupt the FLPL > Free Flight > return to the Flight Plan.
Consider the transit Altitude and prepare your ALT before you reach the xXWPT.
MSFS-Boeing 747-8 Intercontinental — set the speed with the Cockpit AP A/T — Perfect Landing

FSX

- Beechcraft Baron 58 G1000 — No Autopilot problems

MSFS

- Textron Aviation Cessna Citation Longitude — only for long distances (too fast)
- Cessna 172 Skyhawk Textron Aviation
- Boeing 747-8 Intercontinental — set the speed with the Cockpit AP A/T — Perfect Landing

X-Plane

- Lockheed L100-30 — Freeware — FSX native — and the B747 Default - Perfect Landing
- Cessna Skyhawk (G1000)
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Data Files

In your Program Folder

Adf.txt

Vor.txt

Apts.txt (for changes, Apt, Rwy use the AddAirports program)
Intfix.txt (Intersections)

Aptsradar.txt

Rwylength.txt  (calculation is made with the RwyLength program for new runways or changes)

Should you add or change data manually you must observe the precise COLUMN and Space order.

Your Program Folders

FlightPlan
AddAirports

FullSize

Help Files

Joystick Files

MouseClicks

RwyLenght



® Microsoft Flight Simulator X

un R 1 ] v |
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. -..--- i fps
\ el (4] 0] 25
| e Hdg [a¢ ® [Rad & [las [Crui
1127 1636 1068 112 180
las
GESUINY 112.7 QEEEE 1068 |
— ‘ o a0 Ry
10 nm Range e ol £ B i |:|
LR Ug:
= . 5 =]
N [
— e Align to fia;nway
— — - - JLoway .
* e 113°3,2 =
= : TUH vor (0) w84+ (D) 0
- 204% 21,5 (4]
e e a
; "i' : TUH-11 -4 °
N 4% 24,5
A ; (4]
“povpt: 202° 1129
[~ TUR (Ot of Range)

;'IMgw: E31° 293 | Fuw Radial 07
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Included with ATlasHold

T Add Airports {© Raimund Forstmeier) =86 o [m| |

ENT | oo oo | oo
FS Yersion F5x | 13054 | L

ooV j Create Mew "apts’ File [Sorted)

Ajrpart Editor-List
[cao Airport & By Courze Freq Eles [ft]
Hdg [IEETHN [rows cxaz 128 16, RS
17C 167 -—- 47, e
ALT 1120 Airport List
AGL 1112
LAT 46.978391
1| | =
LON 15.443115 lcan Airpart Marme Elevation  Latitude [5 dec] Ln:-ngitude [6 dec]
R e | LOWG | | GRAZ 1120 || 46.993056 ! 15I 439167 |- e
LOWG: GEAZ Fivam - D Courze Frequency ES[;I;;D I:I
Help
FwwData [ 35C | [ 347 |[110.90] Iil
- Latitude [ dec]  Longitude [B dec:] Test
Distance ke liztance
RupData | 46978128 || 15.443187 -
Clear Editar Add!S ave A.pt to Airport List - R
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Included with ATlasHold

MouseClicks performs the movements of a human. example: Start the engines.

E MouseClicks Sys v 1.0.0 =86

E MouseClicks Sys v 1.0.0 %86

R
P |

VP 103 : 384
FR
A\Usl 1920 - 1080
Click Delay
LI 500
File Name 14

A2A CES5NA 172

H| Folder Name |l

TEST

Create "click’ Fle

View 1

Click Description

1/2 Position Switch
(] 1_Left

(] 1_Right

3 Position Switch
L] up

[ ] Middle

[ ] Down

Rotate Switch

(]2 Left

[] 2_Right

[]3 Left

[] 3_Right

Wheel Up / Down
[] wheetup IEH

(] wheelDn [JEl

Mm»xm m= 3=

=MD

| Load ClickFile

Joystick

Fil= Res:
Screen: 1920 : 1080

Joy=16384
key=E
delaykey=
key={F5}
delaykey=
key={a 3}
delaykey=
Eey="( )
delaykey=
key=+{3}
delaykey=
kay=+{T}
delaykey=
key=
delaykey=
key=
delaykey—
key=
delaykey=

Kbd-Detay: 1300 ms
ShortDelay: 100 ms
RepeatDelay: 1300 ms

Joystick

Mumber Input X

Actual or Last saved

View 3

Execute = Off Save T

Ml L Kbd H Keyboard >
Introduction Load Key-File
Create a ClickFile |Saectakby |

BACKSPACE A

Joystick Execution

CAPSLOCK

DELETE

DOWN W
] cd (") [ Shift (+)

Multiple Hey's {100}[] Alt (%)

The Ebd Hook-S5ystem

Different Keyboards

Troubleshooting r x

(1) not selected

a
=3
&
a

Delayed Key x

Assistance

Actual or Last saved
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Full Video Size

Included with ATlasHold

<Emars

ATlasHId - Microsoft Visual Studio [devenv]
Calculatar

Film & TV [Application FrameHost]

Microsoft Text Input Application [Text Input Host
SystemSettings

Video Ul

¥-System [¥-Flane]

o Intrasystem 'FullSize' program. Open as "Administrator’.
Click on [2M] [OFF]
ar
use the Win [Start Key] = F&.

Select 1 open Program then Toggle Border-Less Screen

oK
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Included with ATlasHold

E Extract ICAC, Mation, Town, Apt-Mame, Rwy-10, Rwy-Length from MakeRunways

feet

*

Rwy
Start fu—
=]
2€
EDMO
|C:"'-.Users"'-.Forstmeier‘-.Dncumerrts"ﬁ.‘n.ﬁsual Studia 2ﬂ1ﬂ"-.F'rojec:ts"'-.H'.~| 4

Charts and Airport Data 4
2

2

GFermany
2€44
Zgd44

Germany
T450
7450

Germany
254g
2594g

Help

L-Click » connect to " flightaware " world apt information

R-Click » connect to " SkyVector.com”. World Apt's + Charts.

meter nim
Oberschleissheim Cherschleis: a
205,851 0,435
205,851 0,435
Oberpfaffenhofen Cbherpfaffent
2232, 952 1,233
2282,952 1,233
Landshut Landshut
257,541 0,485
257,541 0,485
Erding Erding 2B
2517,343 1,355
2517,343 1,355
Furstenfeldbruck Furstenfeld:
2735,580 1,477
2735,580 1,477
Dachau-Grokbenried Dachau-Erol
623,526 0,337
623,926 0,337
Hunich HMunich
35591, 966 2,155
35591, 9cc 2,155
35591, 966 2,155
3991, 966 2,155
FEirchdorf-Inn Eirchdorf-Inn
&E%,036 0,36l
cE%, 036 0,36l
iburg Vilsbibura

Credits to Pete Dowson the author of the MakeRunways utility.
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Included with ATlasHold

E Extract ICAQ, Mation, Town, Apt-Mame, Rwy-10, Rwy-Length from MakeRunways

Start Editor an/off

|C:‘aLlsers\Fnrstmeier‘xDDcumems‘x\ﬁsual Studio 21}11}\F'rc:jects‘xﬂu|

— >
Ry fest meter nm
Runway Length Editor Help
Clear Input Relds ADD New Apt

EJFE United States New York Eennedy Intl
13R 14564 4435 107 2,397
31L 14564 4435 147 2,387
4L 11353 34€0,3594 1,868
IR 11353 34€0,354 1,868
13L 29952 3045,5&2 1,644
31 9952 3045 5&2 1,644
47 2401 250 £25 1l 383

| Up | Dn

Country Name

@@:
[ o v T

Rwy ID

Length in FEET

2200 e M

Credits to Pete Dowson the author of the MakeRunways utility.
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E Transform Data Structure %86 - Copyright by Raimund Forstmeier, Padova/ltaly

Hdr |GRAZ

LOWGLTC059543167 47.002008

15.43€614000.0016701115

Sub |GRAZ

LOWG35C053843347 46.977

15.443281110.903470108¢

Record Feld Data
GRAZ:

=l (=
foy]

L1-T - T S N S L ]

09843167

7002006
-15.436614

=

9

1115

i

@
*

1. Page

Clear All

—

NN e e e B e e

s [ Ocm
X

<click > Length Copy x

2]
'

Copy
Copy
Copy
(] Copy
Copy
Copy
Copy
Copy
Copy
(] Copy
Copy
Copy
(] Copy
Copy
Copy
Copy
Copy
Copy
1 Do
[ ] O con
[ 1 Ocom
[ ] OOcon
1 Do
1 Do

X

¢
g

167 01115

78]
=

1

M

-

Line LF R-Align Print Pos

Bind Print Pos. Header

|_[ | |1 [ Header Lne LF [
2 [JHeader [JlnelF []
3 [JHeader [JunelF []
4 [ Header [JlnelF [
5 [ Header [ LinelF
& [ Header [ LinelLF
7 [Header [lnmelF []
8 [JHeader [JlnelF []
9 Header Lne LF ]
1 [JHeader [JlnelF []
2 [JHeader [JLnelF [
3 [JHeader [JunelF [
4 [ Header [JLnelF [

47..51

Rl

Page 2 >> W[ P12 | > [

-
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